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INTRODUCTION GENERALE 

La pollution plastique, omniprésente dans les océans du monde entier, pose un problème 

environnemental majeur en raison de la flottabilité et de la durabilité des plastiques (TEUTENet 

al., 2007). Ces matériaux adsorbent des substances toxiques au cours de leur parcours dans 

l'environnement, conduisant certains chercheurs à les considérer comme des déchets 

dangereux (ROCHMANet al., 2013). Par le biais de la photodégradation et d'autres processus de 

vieillissement, les plastiques se fragmentent et se dispersent dans l'océan (BARNESet al., 

2010), convergeant dans les gyres subtropicaux (LAWet al., 2014). L'impact de cette pollution, 

notamment par ingestion ou enchevêtrement, affecte toute la faune marine, des zooplanctons 

aux cétacés, en passant par les oiseaux et les reptiles marins (GREGORY, 2009). 

D’après MATHIS (2021), malgré de nombreux projets visant à nettoyer les océans, les 

solutions actuelles restent souvent localisées et insuffisantes pour traiter le problème à grande 

échelle. Les interventions en mer sont généralement aléatoires et limitées, et les données 

d'observation actuelles ne suffisent pas pour décrire la distribution globale des déchets marins. 

Les campagnes de quantification sont souvent limitées aux régions côtières et dépendent des 

conditions météorologiques, et les méthodes d'observation varient, rendant les résultats non 

comparables (ARCANGELIet al., 2020 ; CÓZARet al., 2015 ; FAUREet al., 2015 ; GAJŠTet al., 

2016 ; RUIZ-OREJÓNet al., 2016 ; SCHMIDTet al., 2017 ; VAN DER HALet al., 2017 ; 

ZAMBIANCHIet al., 2014). La modélisation numérique peut compléter les données 

manquantes, mais elle nécessite une validation empirique. C'est dans ce contexte que la 

télédétection se révèle être une solution prometteuse pour le suivi continu des déchets marins 

(MARTINEZ-VICENTEet al., 2019). 

La télédétection permet d'acquérir à distance des informations sur la surface terrestre en 

mesurant les rayonnements électromagnétiques réfléchis par les objets étudiés1. Les satellites 

peuvent ainsi compléter les données obtenues par chalutage à la surface des océans 

(GARABA&DIERSSEN, 2018). Les efforts pour utiliser la télédétection dans la détection des 

plastiques ont montré des résultats prometteurs, avec de nombreux travaux démontrant un 

potentiel raisonnable de détection et de cartographie des déchets plastiques 

(GARABA&DIERSSEN, 2018). La communauté scientifique et les agences spatiales travaillent 

actuellement à l'élaboration de missions satellitaires pertinentes pour quantifier cette pollution 

(TOPOUZELISet al., 2020, 2019). 

                                                
1Larousse, ‘Définitions : télédétection’ 
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Avec une bande littorale de 2148 km, l'Algérie abrite un écosystème fragile. Le littoral 

algérois est particulièrement vulnérable en raison de la densité de population élevée et des 

activités industrielles et économiques intenses (AND, 2020). Ces activités exercent une 

pression environnementale considérable, transportant des déchets plastiques vers les côtes par 

le biais des cours d'eau et du lessivage côtier (AND, 2020). Malgré le problème des débris 

marins, plusieurs études fondamentales en Algérie explorent le potentiel de détection de la 

pollution plastique à travers des enquêtes in-situ et des observations en laboratoire 

(BELABED&TAHAR, 2019 ; BENCHEIKH&CHIHEB, 2021 ; BOUHALI, 2023 ; 

BOUMIMEZ&HASSAINE, 2018 ; BOURAS&BENAISSA, 2020 ; ELBACHIR&HAMZA, 2021 ; 

LABADLA&SOUAISSID, 2021 ; OUDINA&AGRANE, 2018 ; SETITIet al., 2021 ; TAIBIet al., 

2016). Cependant, l'évaluation des débris plastiques marins reste longue et coûteuse. 

À cette fin, cette étude se propose de mener les premières investigations sur la télédétection 

des débris plastiques dans le littoral Algérois, en se concentrant sur la baie d'Alger, Zemmouri 

et Bou Ismail. Les questions principales que ce mémoire souhaite aborder sont les suivantes : 

 Les techniques de télédétection spatiale sont-elles efficaces pour la détection et la 

quantification des débris plastiques dans les eaux côtières de l’Algérois ? 

 Quelles sont les différentes sources potentielles de pollution plastique dans la baie 

d'Alger, Zemmouri et Bou Ismail ? 

 Quels sont les défis et lacunes dans la gestion des déchets marins en Algérie ? et 

quelles recommandations peuvent être formulées pour une gestion durable des déchets 

plastiques marins ? 

Ce mémoire est structuré en quatre chapitres : 

Le premier chapitre offre une synthèse bibliographique qui définit les termes clés associés à la 

pollution plastique. Il met également en lumière le cadre législatif et institutionnel, 

notamment la stratégie nationale et la réglementation algérienne de gestion des déchets 

plastiques. 

Le deuxième chapitre se concentre sur la zone d’étude, l'Algérois, en détaillant ses 

caractéristiques et en soulignant les principaux facteurs contribuant à la pollution plastique. 

Le troisième chapitre présente les données et les méthodes utilisées pour étudier la pollution 

plastique dans la zone d’étude. 

Enfin, le quatrième chapitre expose les résultats obtenus ainsi que leur discussion. 
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1 GENERALITES 

1.1 Notions sur la Pollution Plastique 

1.1.1 Définition de la Matière Plastique 

Le plastique représente un matériau synthétique issu souvent du traitement du pétrole brut, 

avec la capacité d'être façonné et moulé en diverses formes, ce qui en fait un matériau 

extrêmement polyvalent (FRANCE INDUSTRIE, 2020). 

En Algérie, bien qu'il n'y ait pas de définition précise du plastique dans la législation, le 

Dictionnaire environnement en ligne décrit que : Les matières plastiques (classique, non 

biodégradable), sont des matériaux organiques de synthèse basés sur l’emploi de 

macromolécules (polymères), il est notamment utilisé pour les emballages, en raison de sa 

flexibilité (capacité à lui donner une forme voulue) et de sa légèreté. 

C’est à partir de la fin du XIXe siècle que sont mis au point les premiers plastiques 

synthétiques, résultant alors de la transformation chimique de polymères naturels tels que la 

cellulose et la caséine. Au XXe siècle, avec l’essor de la chimie et le développement de 

nouvelles matières plastiques pétro-sourcées, le plastique s’est progressivement imposé 

comme une matière incontournable pour répondre à de nombreux défis de notre société 

(HESTINet al., 2022).  

1.1.2 Classification de la Matière Plastique 

Les matières plastiques dérivent de polymères, des macromolécules formées par la 

transformation du charbon, du pétrole ou du gaz naturel. Chaque polymère possède des 

propriétés, une structure et une taille distinctes, pouvant être améliorées par l'ajout d'additifs 

tels que des charges ou des plastifiants (GUILLEMOT&PATRASCU, 2019). 

1.1.2.1 Classification par taille  

D’après TheOceanCleanup2, les microplastiques font référence à des particules de plastique 

mesurant moins de 5 millimètres. Ils peuvent comprendre des fragments, des flocons, des 

fibres ou des granulés de pré-production, également appelés nurdles. Les microplastiques 

primaires, tels que les nurdles et les microbilles cosmétiques, sont délibérément produits dans 

cette plage de taille. D'autre part, les microplastiques secondaires proviennent de la 

                                                
2TheOceanCleanup est une organisation internationale non gouvernementale d'ingénierie environnementale à but 

non lucratif qui développe des technologies visant à débarrasser les océans du plastique. 
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dégradation d'objets plus grands, se manifestant sous forme de fragments, de fibres, d'écailles       

de peinture, etc. 

Les macroplastiques, généralement définis comme des objets plus grands que 5 millimètres, 

sont également sous-catégorisés à TheOceanCleanup. Cette classification distingue les 

mésoplastiques (0,5 à 5 cm), les macroplastiques (5 à 50 cm) et les mégaplastiques (> 50 cm). 

Cette approche nuancée reconnaît la gamme diversifiée de tailles de la pollution plastique. La 

surveillance complète du spectre complet de tailles de la pollution plastique est impérative, 

étant donné que les objets plus grands laissés dans l'environnement peuvent se fragmenter 

progressivement en composants plus petits, nécessitant une compréhension de son évolution 

au fil du temps (JULIENNE, 2019). 

1.1.2.2 Classification selon la composition 

Selon la base de données «  Classification des matières plastiques » de l’Institut Nationale de 

la Recherche Scientifique (GUILLEMOT&PATRASCU, 2019) du Québec, deux grandes 

catégories de plastiques se distinguent :  

 Les plastiques thermoplastiques: fondent sous l’effet de la chaleur et se solidifient par 

refroidissement. Les Thermoplastiques représentent une catégorie prédominante, couvrant 

environ 90 % des plastiques employés dans le domaine de l'emballage ainsi que dans la 

fabrication d'autres articles à usage unique, communément appelés plastiques jetables 

(A.N.D, 2019). D’après Paprec3, les trois principaux sont : le polyéthylène (PE), le 

polypropylène (PP) et le polychlorure de vinyle (PVC). Ensuite, viennent le polystyrène et 

les polyesters thermoplastiques.Ces matériaux se distinguent par une flexibilité 

remarquable dans la production d'une variété d'articles quotidiens (exemple : bouteille 

d'eau, bouchon de bouteille, flacon de lessive, etc.). 

 Les plastiques thermodurcissables: subissent une transformation irréversible, 

conservant ainsi leur forme une fois constitués. Ils constituent une classe distincte de 

matériaux synthétiques qui, après avoir subi un processus de chauffage et de mise en 

forme initial, conservent leur structure de manière permanente, étant incapables d'être 

refondus et remodelés ultérieurement (A.N.D, 2019). Parmi ces plastiques, on compte 

les polyimides utilisés pour la fabrication de circuits imprimés ou de câbles. On trouve 

également les polyesters insaturés qui entrent dans la composition de laques, vernis et 

colles (SEA Plastics, 2020). 

                                                
3Paprec ou Groupe Paprec : entreprise française de collecte et recyclage de déchets industriels et ménagers. 
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1.1.3 Sources de la Pollution Plastique 

La production de plastique à l'échelle mondiale a connu une augmentation exponentielle en 

l'espace d'une seule vie humaine. La quantité est passée de 2 millions de tonnes en 1950 à plus 

de 390 millions de tonnes en 2021 (UFFELEN, 2021). Cependant, il est important de noter que 

ces chiffres ne tiennent pas compte des fibres synthétiques, ce qui indique que la production 

réelle est nettement plus élevée. 

De manière remarquable, plus de la moitié de la production totale de plastique a été introduite 

sur le marché après l’année 2000 (Figure 1). Les projections suggèrent que d'ici 2050, la 

production devrait quadrupler par rapport aux niveaux de 2019, atteignant environ 1480 

millions de tonnes (JUNTILLA, 2021). Pour mettre cela en perspective, cela représente près de 

trois fois le poids total de la population mondiale actuelle. 

 

Figure 1:Production annuelle mondiale de plastique en millions de tonnes. 

(Source: JUNTILLA, 2021) 

La pollution plastique trouve ses racines dans diverses origines. Environ 80 % du plastique 

présent dans les océans provient de sources terrestres, avec 6,1 millions de tonnes de déchets 

plastiques rejetées dans la sphère marine en 2019, dont 1,7 million entraîné par les cours d'eau 

(OECD, 2022). 

Les activités industrielles, les navires de transport, les activités agricoles, la pêche, le tourisme 

côtier et les activités nautiques sont autant de contributeurs à la pollution plastique. De plus, 

les phénomènes météorologiques tels que les tempêtes, ouragans, catastrophes naturelles, 

orages et fortes pluies déplacent les déchets plastiques des terres agricoles et des 

agglomérations urbaines vers les océans. 
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La gestion des déchets joue également un rôle crucial. À l'échelle mondiale, seuls 9 % des 

déchets plastiques sont recyclés, 19 % sont incinérés, et 50 % finissent dans des décharges. 

Les 22 % restants sont abandonnés dans des décharges sauvages, brûlés à ciel ouvert ou 

rejetés dans l'environnement terrestre ou marin (OECD, 2022). La saturation des réseaux 

d'assainissement urbains contribue également au déversement direct des eaux usées et de leurs 

déchets dans les milieux naturels.  

La Figure 2 aide à visualiser les interactions complexes auxquelles les plastiques sont soumis 

tout au long de leur cycle de vie et situe les chiffres présentés au-dessus dans leur contexte. 

 

Figure 2: Interactions complexes des plastiques tout au long de leur Cycle de Vie. 

(Source: OECD, 2022) 

1.1.4 Dangers du Plastique 

La prolifération des plastiques combinée à une gestion inadéquate des déchets en fin de vie a 

conduit à une fuite généralisée et persistante de plastiques. La longévité des plastiques est 

particulièrement préoccupante. Par exemple, des produits en plastique à usage unique tels que 

des sacs en plastique LDPE et des bouteilles de lait HDPE pourraient avoir des demi-vies 

estimées de 5 à 250 ans sur terre et de 3 à 58 ans dans les environnements marins (CHAMASet 

al., 2020). En revanche, les tuyaux en HDPE nécessitent des milliers d'années pour se 

dégrader complètement, avec une demi-vie estimée de 1 200 ans (CHAMASet al., 2020). 
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Dans les milieux aquatiques, les effets négatifs les plus visibles sur la faune marine sont 

l'enchevêtrement des organismes marins dans les débris plastiques flottants et l'augmentation 

de la mortalité suite à l'ingestion de macro et microplastiques par des espèces marines telles 

que les moules, les tortues, les poissons et les oiseaux marins. Au moins 690 espèces de la 

faune sauvage, ainsi que les récifs coralliens, sont connues pour être affectées 

(GALL&THOMPSON, 2015). Cependant, les conséquences négatives des plastiques vont au-

delà de ces impacts de premier ordre. Des microplastiques ont été documentés dans le tube 

digestif de plusieurs types de moules et de poissons destinés à la consommation humaine 

(LUSHERet al., 2017). Ainsi, l'ingestion de fruits de mer contaminés par des microplastiques a 

également été identifiée comme une voie d'exposition potentiellement importante pour les 

humains. 

La contamination par les microplastiques n'est pas exclusive aux environnements marins - elle 

a également été documentée dans les environnements d'eau douce et terrestres, ainsi que dans 

les aliments et les boissons, tels que l'eau du robinet et l'eau en bouteille (KOSUTHet al., 2018; 

MINTENIGet al., 2019). Les humains sont également exposés aux microplastiques en inhalant 

des particules et des fibres en suspension dans l'air, et des microplastiques ont été signalés tant 

dans les environnements intérieurs qu'extérieurs (ALLENet al., 2019 ; GASPERIet al., 2018). 

Alors que la majorité des émissions de microplastiques ont tendance à rester proches de leur 

source, où elles augmentent les niveaux de concentration de particules en suspension au 

niveau du sol, certaines particules peuvent parcourir de longues distances, en fonction de 

l'emplacement et des conditions atmosphériques. 

Les plastiques peuvent également agir comme un réservoir et un vecteur de transport pour les 

produits chimiques et les polluants organiques persistants (POPs), qui s'accumulent à la 

surface des plastiques en mer. La fragmentation des plastiques peut intensifier la lixiviation 

des substances chimiques dans l'environnement environnant.  

De plus, la fuite de plastiques en mer entraîne des coûts économiques substantiels pour les 

communautés côtières en raison des impacts négatifs potentiels sur la pêche et le tourisme. 

Les plastiques peuvent affecter la durabilité des pêcheries, tandis que la pollution plastique 

sur les plages dissuade les visiteurs, causant des difficultés financières aux communautés 

locales dépendantes du tourisme. BEAUMONTet al. (2019) estiment que le coût économique de 

la perte des services écosystémiques marins est d'environ 3 300 dollars par tonne de plastique 

marin par an. 
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1.2 Les déchets plastiques en Méditerranée 

Considérée comme la mer la plus touchée par la pollution à l'échelle mondiale, la 

Méditerranée subit une transformation alarmante en devenant un immense dépôt de déchets 

plastiques. Cette situation découle de la densité élevée de population, des flux touristiques et 

maritimes importants, et de l'absence de systèmes de gestion efficace des déchets dans 

plusieurs pays riverains. Ces facteurs contribuent à des niveaux records de pollution, mettant 

en danger la vie marine et la santé humaine (COZARet al., 2015). Selon BOUCHER&BILLARD 

(2020), la quantité totale de plastique accumulée dans la mer Méditerranée atteint 

actuellement environ 1,2 million de tonnes. Les chercheurs soulignent l'incertitude entourant 

cette estimation, car la plupart des recherches antérieures se concentrent principalement sur 

les plastiques à la surface de la mer, une fraction négligeable du stock total (Tableau 1). 

Tableau 1: Estimations des apports de déchets plastiques et concentrations fournies dans la littérature. 

(Source : BOUCHER&BILLARD, 2020) 

Combien de plastique flotte actuellement dans la mer Méditerranée ? 

Micro- et macroplastiques (tonnes) Commentaire Source 

1 000 – 3 000 

Uniquement en se basant sur les 
échantillonnages de manta-trawl extrapolés à 
l'ensemble de la mer Méditerranée  

(1 compartiment, celui de la fraction flottante) 

COZARet al. (2015) 

873 – 2 576 SUARIAet al. (2016) 

2 3150 ERIKSENet al. (2014) 

1 455 RUIZ-OREJONet al. (2016) 

288 – 1 840 

Fournit également les quantités de plastique dans 
d'autres compartiments, qui représentent 
largement la majeure partie par rapport à la 
fraction flottante 

BOUCHER&BILLARD (2020) 

Combien de plastique fuit-il chaque année ? 

Macroplastiques (tonnes/an) Microplastiques (tonnes/an) Commentaire Source 

150 000 – 500 000 70 000 – 130 000 

Estimation pour les mers 
européennes, la grande majorité 

étant considérée comme entrant en 
Méditerranée. 

ALESSIet al. (2018) 

570 000 

 Données actualisées sur les fuites 
annuelles dans l'ensemble de la 
mer Méditerranée. 

DALBERG ADVISORS 
(2019) 

745 232  
(Faible: 447,139;  
élevé: 1,192,372 ) 

 Estimations des fuites en utilisant 
trois taux de libération différents : 
faible : 15 %, central : 25 % et 
élevé : 40 %. 

JAMBECKet al. (2015) 

216 269 13 196 

Empreinte annuelle de plastique en 
mer estimée pour la mer 
Méditerranée, provenant de 33 
pays. 

BOUCHER&BILLARD 
(2020) 
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BOUCHER&BILLARD (2020) soulignent qu’environ 229 000 tonnes de déchets plastiques 

rejoignent la Méditerranée chaque année, avec une fourchette possible de 150 000 à 610 000 

tonnes. Ces débris se composent principalement de macroplastiques (94%) et de 

microplastiques (6%). En raison de la forte population en bord de mer en Égypte (102 

millions d'habitants) et d'un taux de gestion inadéquate des déchets atteignant 95%, le pays 

contribue massivement à cette pollution, représentant environ 75 000 tonnes par an, soit près 

d'un tiers du total. Les principaux pays émetteurs suivants sont l'Italie (38 000 tonnes), la 

Turquie (25 000 tonnes) et l'Algérie (14 000 tonnes). 

En général, les "points chauds de la pollution plastique" sont fréquemment localisés près des 

embouchures des grands fleuves comme le Nil, le Rhône ou le Pô, ainsi que près des grandes 

villes côtières. Les exemples incluent Alger, Alexandrie, Barcelone, Naples et Izmir 

(BOUCHER&BILLARD, 2020). 

Comme le montre la Figure 3, la pollution plastique n'est pas confinée aux seules zones 

côtières. Certains pays non limitrophes de la Méditerranée mais faisant partie de son réseau 

fluvial, comme le Soudan (Nil) ou la Suisse (Rhône), contribuent également de manière 

significative aux déchets plastiques. L'étude indique que 35 % des rejets de macroplastiques 

en mer proviennent de zones situées à moins de 23 km des côtes, tandis que les 65 % restants 

proviennent de l'intérieur des terres, transportés par ruissellement vers le milieu marin. 

 

Figure 3: Estimation du volume de déchets plastiques déversés dans la mer Méditerranée par pays, en 
tonnes par an. (Source : GAUDIAUT, 2022) 
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1.3 Le plastique sur les côtes algériennes 

D’après BABAYEMIet al. (2019), l’Algérie est classée parmi les six pays ayant la part la plus 

élevée d’utilisation de plastique en Afrique. La tendance temporelle des importations de 

plastiques vierges en Algérie montre une augmentation constante, passant de 0,096 Mt en 

1992 à environ 1,38 Mt en 2016. De 1992 à 2017, environ 13,14 Mt de plastique ont été 

importées, représentant environ 11,2 % des importations totales de plastiques primaires sur le 

continent africain (Figure 4). 

 

Figure 4: Tendance temporelle des importations de plastique en Algérie. 

(Source: BABAYEMIet al., 2019) 

Environ 0,52 Mt de déchets plastiques sont mal gérés dans le pays chaque année (JAMBECKet 

al., 2015).Des concentrations élevées de déchets plastiques flottants (> 2 cm) et de 

microplastiques (> 200 μm) ont été signalées dans le bassin offshore algérien 

(SUARIA&ALIANI, 2014). Des niveaux plus élevés de microplastiques ont également été 

trouvés dans les sédiments de surface des côtes nord-africaines de la mer Méditerranée 

(TATAet al., 2020).  

Cependant, l'étendue et l'impact de la pollution microplastique dans l'environnement marin 

algérien demeurent largement spéculatifs, car aucune donnée de référence n'existe 

actuellement pour les eaux côtières algériennes. L'Algérie se trouve ainsi dans une position où 

peu d'études spécifiques ont été menées (Tableau 2). Ceci est notable malgré la considération 

générale selon laquelle l'environnement marin de l'Algérie est particulièrement susceptible à 

l'accumulation de débris marins (MANSUIet al., 2020), en raison de la modernisation accrue 

du pays, de son développement économique et de son contexte hydrodynamique particulier. 
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Tableau 2: Synthèse des travaux réalisés en Algérie sur les microplastiques. 

Référence Zone d’étude Matrice étudiée Paramètres étudiés 

AMENOUCHE&DOUMANDJI 

(2015) 
Baie de Bou Ismail Eau de surface 

Qualification et quantification des 

microplastiques. 

TAIBIet al. (2016) Plages de Mostaganem Sédiment 
Qualification et quantification des 

micro- et macroplastiques. 

OUDINA&AGRANE (2018) Cote Jijelienne Sédiment, eau de surface 
Qualification et quantification des 
microplastiques. 

BELABED&TAHAR (2019) Golfe d’Annaba Eau de surface Quantification des microplastiques 

TATAet al. (2020) Golfe d’Annaba Sédiment 
Abondance, répartition et 
caractéristiques des 
microplastiques. 

BENCHEIKH&CHIHEB (2021) Golfe d’Annaba Sédiment 
Evaluation quantitative et 
qualitative des micro-déchets. 

SETITIet al. (2021) Baie de Bou Ismail Eau de surface 
Quantification, caractérisation et 
distribution spatio-temporelle des 
microplastiques flottants. 

ZEGHDANIet al.(2023) Golfe de Bejaia Biote 

Intensité de la consommation de 
plastique par les poissons. 
Morphotype, taille et couleur des 
particules de plastique récupérées. 

 

1.4 Stratégie nationale et règlementation Algérienne de gestion des déchets plastiques 

1.4.1 Cadre légal et institutionnel 

Depuis le début des années 2000, un ensemble significatif de lois a été élaboré pour aligner 

l'Algérie sur ses engagements internationaux et aborder les questions environnementales dans 

le contexte du développement durable. Les principaux piliers du droit environnemental sont 

principalement énoncés dans les textes de lois mentionnés dans le Tableau 3. 

Dans le domaine de la gestion des déchets, la loi 01-19 est renforcée par plusieurs textes 

d'application, tout en se basant sur les principes suivants : 

 Prévention et réduction de la production et de la nocivité des déchets à la source. 

 Organisation du tri, de la collecte, du transport et du traitement des déchets. 

 Valorisation des déchets par le réemploi, le recyclage et d'autres actions visant à 

obtenir des matériaux réutilisables ou de l'énergie à partir de ces déchets. 

 Traitement écologiquement rationnel des déchets. 

 Information et sensibilisation des citoyens sur les risques liés aux déchets, leur impact 

sur la santé et l'environnement, ainsi que les mesures prises pour prévenir, réduire ou 

compenser ces risques. 



Généralités 
 

13 

 

Tableau 3: Lois relatives au Développement Durable, à la Protection de l’Environnement et à la 
Gestion des Déchets (Source: AND, 2020) 

Loi Intitulé/ Contenu 

La loi n ̊01-19 du 12/12/2001 
Relative à la gestion, au contrôle et à l’élimination des déchets. Elle définit les 
principes de base qui conduisent à une gestion intégrée des déchets, de leur 
génération à leur élimination. 

La loi n ̊03-10 du 19/07/2003 
Relative à la protection de l’Environnement dans le cadre du développement 
durable. Elle consacre les principes généraux d’une gestion écologique rationnelle. 

La loi n ̊04-20 du 25/12/2004 

Relative à la prévention des risques majeurs et à la gestion des catastrophes dans le 
cadre du développement durable. Elle définit clairement les responsabilités de 
chacun des acteurs impliqués dans le domaine de la prévention au niveau des zones 
et des pôles industriels. La Commune est la collectivité territoriale de base de 
l’Etat. Elle est dotée de la personnalité morale et de l’autonomie financière. 

La loi n  ̊11-10 du 22/06/2011 

La Commune exerce ses prérogatives dans tous les domaines de compétence qui lui 

sont dévolus par la loi. Elle concourt avec l’Etat, notamment, à l’administration et à 
l’aménagement du territoire, au développement économique, social et culturel, à la 
sécurité, ainsi qu’à la protection et l’amélioration du cadre de vie des citoyens. 

 

Dans le secteur de la gestion des déchets en Algérie, divers intervenants, aussi bien à l'échelle 

nationale que locale, jouent un rôle central. Au niveau national, le Ministère de 

l'Environnement, à travers l'Agence Nationale des Déchets, accompagne les acteurs locaux 

tels que les collectivités locales. De même, le Ministère de l'Intérieur, des Collectivités 

Locales et de l'Aménagement du Territoire octroie un soutien financier et logistique crucial 

aux Assemblées Populaires Communales pour la gestion des déchets urbains. D'autres 

ministères spécialisés, tels que ceux de la Santé, de l'Industrie, de l'Agriculture et de la Pêche, 

sont également impliqués dans des aspects spécifiques de la gestion des déchets.  

À l'échelle locale, la responsabilité de la gestion des déchets repose principalement sur les 

Assemblées Populaires Communales, les Établissements Publics à caractère Industriel et 

Commercial (EPIC) de collecte et de nettoiement, ainsi que les EPIC de Gestion des Centres 

d'Enfouissement Technique (CET). 

En outre, des acteurs privés, tels que les opérateurs économiques actifs dans la collecte et le 

transport des déchets, ainsi que ceux impliqués dans le traitement, contribuent 

significativement à cette dynamique. Ces opérateurs privés participent à des activités variées, 

de la collecte des déchets municipaux au traitement par le biais de procédés tels que le 

recyclage, la récupération et l'incinération (AND, 2020). 

De nombreuses associations, activant dans le domaine de la protection de l'environnement, 

contribuent également de façon effective à ce propos, et ce via des activités de vulgarisation et 
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de sensibilisation des citoyens ainsi que l'organisation de campagnes de nettoiement et de 

bénévolat au niveau des espaces communs, naturels, etc. 

1.4.2 Cadre opérationnel 

Depuis de nombreuses années, la gestion des déchets est devenue une préoccupation majeure 

à la fois au niveau local et national, impliquant l'ensemble des acteurs, qu'ils soient citoyens, 

publics ou privés. Elle est aujourd'hui reconnue comme un pilier essentiel de la politique de 

développement durable. Dans cette perspective, le Ministère de l'Environnement (ME) a 

initié, en collaboration avec divers secteurs concernés, une politique nationale de gestion des 

déchets, avec des objectifs clairement définis, notamment : 

 La préservation de l'hygiène publique et la propreté des agglomérations. 

 L'amélioration du cadre de vie des citoyens et la protection de leur santé. 

 L'élimination saine et écologiquement rationnelle des déchets. 

 La valorisation des déchets recyclables. 

 Le développement d'une économie verte, respectueuse de la nature et profitable. 

 La création d'emplois. 

Afin de concrétiser ces objectifs, diverses stratégies et programmes ont été élaborés, parmi 

lesquels figurent : 

 Le Plan National d'Actions pour l'Environnement et le Développement Durable 

(PNAE-DD). 

 Le Programme National de Gestion Intégrée des Déchets Ménagers et Assimilés 

(PROGDEM). 

 Le Plan National de Gestion des Déchets Spéciaux (PNAGDES). 

 La Stratégie Nationale de Gestion Intégrée des Déchets à l'horizon 2035 (SNGID-

2035). 

1.4.3 Analyse critique de la prise en charge de la gestion des déchets marins par les 

textes juridiques 

Depuis son indépendance en 1962, l’Algérie a connu des transformations politiques et 

environnementales. Malgré les défis de la reconstruction, les préoccupations 

environnementales ont progressivement été intégrées dans les chartes et constitutions du pays 

(Annexe 1). Cependant, la gestion des déchets marins en Algérie, notamment les déchets 

plastiques, présente encore de nombreuses lacunes et reste un problème urgent et complexe 

nécessitant une attention immédiate. 
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1.4.3.1 Limites et insuffisances de la législation environnementale 

L'Algérie a fait de nombreux progrès en matière de protection de l'environnement, mais leur 

mise en œuvre reste limitée. Les textes législatifs existants sont confrontés à des restrictions et 

des lacunes, ce qui entrave l'efficacité des politiques environnementales. Souvent, les lois et 

règlements relatifs à l'environnement ont été créés en réponse aux pressions et aux normes 

internationales, négligeant les besoins locaux. D’après TABTI (2024), cette approche est 

compliquée par un foisonnement de réglementations et d'institutions, en grande partie à cause 

de la faiblesse des capacités institutionnelles chargées de les appliquer. Cette faiblesse conduit 

à une incohérence dans l'application des lois.  

En outre, la gestion des questions environnementales a fréquemment changé de portefeuille 

ministériel, mettant en évidence les défis structurels et institutionnels. KAMTO (2014) soulève 

des questions cruciales : "Quelles institutions pour une mise en œuvre effective du droit de 

l’environnement? Comment ces institutions doivent-elles opérer et à quelles conditions 

peuvent-elles être efficientes?". 

Cette situation souligne la nécessité urgente de réévaluer et de réformer les institutions 

environnementales notamment celles chargées de la gestion des déchets marins en Algérie 

afin d'assurer une application efficace des lois environnementales, tout en tenant compte des 

particularités locales. 

1.4.3.2 Instabilité institutionnelle dans la gestion de l’environnement 

L'Algérie a connu une instabilité institutionnelle significative dans la gestion de 

l'environnement depuis son indépendance, illustrée par la succession de divers ministères avec 

des missions évolutives (Tableau 4). Cette évolution institutionnelle témoigne de l'importance 

croissante accordée à la protection de l'environnement en Algérie. Toutefois, cette instabilité a 

entraîné des inefficacités structurelles et opérationnelles. D’après TABTI (2024), la succession 

rapide de ministères avec des missions parfois redondantes ou mal coordonnées a souvent 

abouti à une application incohérente des politiques environnementales. 

Tableau 4 : Missions évolutives des institutions environnementales en Algérie. 

Période Institution Missions évolutives 

1962 – 1977 Ministère de l'Agriculture et de la Réforme 
Protection des ressources naturelles, sans une 
vision intégrée de la gestion environnementale. 

1977 – 1983 Ministère de l'Environnement 
Première tentative de structuration dédiée à la 
gestion environnementale globale. 
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Période Institution Missions évolutives 

1983 – 1991  Ministère de l'Hydraulique et de l'Environnement 
Intégration de la gestion de l'eau dans les 
politiques environnementales. 

1991 – 2002 
Ministère de l'Environnement et de la Protection 
de la Nature 

Protection de la biodiversité et les écosystèmes. 

2002 – 2014 
Ministère de l'Aménagement du Territoire et de 
l'Environnement 

Coordination des politiques environnementales 
avec la planification territoriale. 

2014 – 2019 
Ministère de l'Environnement et des Énergies 

Renouvelables 

Promotion des énergies alternatives pour réduire 

la dépendance aux énergies fossiles. 

Depuis 2019 

Novembre 2020 : Ministère de l'Environnement  
Septembre 2022 : Ministère de l'Environnement 
et des Énergies Renouvelables 

Orientation stratégique vers une transition 
écologique et énergétique. 

 

1.5 Notions sur la télédétection 

1.5.1 Mission Sentinel-2 

Le satellite Sentinel-2 est une mission spatiale du programme Copernicus de l'Agence 

Spatiale Européenne (ESA) qui consiste en deux satellites, Sentinel-2A et Sentinel-2B, placés 

en orbite héliosynchrone. Il est spécialisé dans l'observation de la surface de la Terre et 

dispose d'un instrument multispectral haute résolution (MSI) équipé de 13 bandes spectrales 

couvrant une large gamme du spectre visible et infrarouge, offrant une résolution spatiale 

allant jusqu'à 10 mètres pour certaines bandes (Tableau 5). 

Tableau 5: Caractéristiques des bandes spectrales de Sentinel-2 (Source : TACONET, 2019) 

Bandes de Sentinel-2 Longueurs d’onde centrales (µm) Résolution (m) 

Bande 1 - Aérosol côtier 0,443 60 

Bande 2 – Bleu 0,490 10 

Bande 3 – Vert 0,560 10 

Bande 4 – Rouge 0,665 10 

Bande 5 - VRE1 0,705 20 

Bande 6 - VRE2 0,740 20 

Bande 7 - VRE3 0,783 20 

Bande 8 – PIR 0,842 10 

Bande 8A – PIR étroit 0,865 20 

Bande 9 - Vapeur d’eau 0,945 60 

Bande 10 - SWIR Cirrus 1,375 60 

Bande 11 - SWIR-1 1,610 20 

Bande 12 – SWIR-2 2,190 20 

Abréviations: VRE : Végétation "Red Edge"; PIR : Proche Infra-Rouge; SWIR :Short Wave Infra-Red 
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1.5.2 Les techniques de classification d’image 

Les méthodes de classification regroupent des zones de l'image présentant des réponses 

spectrales similaires en classes distinctes. Ces techniques reposent sur des principes 

d'apprentissage automatique et se divisent en deux catégories : supervisée et non supervisée. 

Dans le cadre d'un apprentissage non supervisé, les pixels de l'image sont regroupés en 

fonction de leur similarité à l'aide de techniques de clustering4, et les classes d'occupation des 

sols sont définies ultérieurement (PELLETIER, 2017).  

Cependant, la majorité des recherches sur l'extraction de l'occupation du sol à partir d'images 

satellites privilégient les méthodes de classification supervisée basées sur les pixels 

(DERDJINI, 2017). Cette technique repose sur une connaissance préalable du terrain étudié. La 

démarche scientifique reste cohérente entre les différentes méthodes de classification, bien 

que le choix des algorithmes de classification puisse varier (DERDJINI, 2017). 

                                                
4Le clustering est une étape clé dans la classification non supervisée qui consiste à regrouper automatiquement 
les pixels de l'image en clusters (classes spectrales homogènes), sans aucune information a priori sur les types 
d'occupation du sol (KNUDBY, 2021). 
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2 ZONE D’ETUDE : L’ALGEROIS 

Ce chapitre a pour objectif de présenter la zone d'étude : l'Algérois. L'analyse du littoral 

comprendra une description de sa situation géographique, administrative, hydrographique et 

hydrodynamique, ainsi qu'une présentation de son évolution démographique et urbanistique. 

Cette sélection est motivée par la forte dynamique démographique qu’elle y connaît ainsi que 

les modes de production et de consommation responsables des dégradations que subit le 

littoral algérois depuis quelques décennies. De plus, ce choix a été influencé par les résultats 

du site Global Plastic Watch5, qui a identifié en 2021, 74 sites de déchets plastiques le long du 

littoral algérien, dont 27 se trouvent à moins de 250 mètres des cours d'eau. L’Algérois 

englobe 10 de ces sites, dont 4 sont situés dans cette intégrale. 

2.1 Situation géographique et administrative 

La zone d’étude s’étend sur 120 km, elle englobe toute la zone de l’Algérois, comprenant la 

baie de Bou Ismail à l’Ouest, la baie de Zemmouri à l’Est, et la baie d’Alger au centre (Figure 

5). Trois wilayas sont incluses dans cette zone, à savoir Alger, Tipaza et Boumerdes, avec 

respectivement 57, 28 et 32 communes, dont 43 sont des communes côtières. Les communes 

côtières incluses dans la zone d'étude sont présentées dans la Figure 6 et le Tableau 6.  

 

Figure 5: Situation géographique de la zone d’étude. 

                                                
5Global Plastic Watch (GPW) est une plateforme numérique qui cartographie la pollution plastique dans le 

monde en temps quasi réel en utilisant une combinaison unique d'imagerie satellite et d'intelligence 

artificielle.https://globalplasticwatch.org/ 

https://globalplasticwatch.org/
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Figure 6: Les communes côtières incluses dans la zone d'étude. 

Les numéros représentent les communes côtières spécifiées sur le tableau suivant : 

Tableau 6 : Les communes côtières incluses dans la zone d'étude. 

Wilaya Nombre N°  Commune Code ONS 

Alger 19 

1 Alger-Centre 1601 

2 Belouizdad 1604 

3 Bab El Oued 1605 

4 Bologhine 1606 

5 Casbah 1607 

6 Hussein Dey 1617 

7 El Hammamet 1624 

8 Raïs Hamidou 1625 

9 Mohammadia 1629 

10 Bordj El Kiffan 1630 

11 Ain Taya 1638 

12 Bordj El Bahri 1639 

13 El Marsa 1640 

14 Haraoua 1641 

15 Reghaia 1643 

16 Ain Benian 1644 

17 Staoueli 1645 

18 Zeralda 1646 

19 Cheraga 1650 

Boumerdes 7 

20 Boumerdes 3501 

21 Djinet 3509 

22 Zemmouri 3511 

23 Thenia 3515 

24 Corso 3519 

25 Boudouaou-El-Bahri 3532 

26 Leghata 3535 
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Wilaya Nombre N°  Commune Code ONS 

Tipaza 7 

27 Tipaza 4201 

28 Douaouda 4204 

29 Khemisti 4206 

30 Aïn Tagourait 4217 

31 Fouka 4225 

32 Bou Ismaïl 4226 

33 Bouharoun 4230 

2.1.1 Baie d’Alger  

La baie d'Alger, au cœur du littoral algérien et située dans la wilaya d'Alger, la capitale du 

pays, présente des coordonnées géographiques entre 3°01'00" Est et 3°14'30" Est en 

longitude, et entre 36°44'30" N et 36°49'15" N en latitude. Sa morphologie semi-circulaire 

s'étend sur environ 35 kilomètres de linéaire côtier, avec une ouverture mesurant environ 18 

kilomètres d'est en ouest et 7 kilomètres du nord au sud. Cette configuration conduit à une 

accumulation significative de pollution en raison d’une circulation plus restreinte des eaux. La 

baie est délimitée à l'est par le Cap Matifou et à l'ouest par le Cap Caxine, couvrant une 

superficie estimée à environ 180 km² (Figure 7). 

 

Figure 7: Situation géographique de la baie d’Alger. 

2.1.2 Baie de Zemmouri 

La baie de Zemmouri, localisée dans la wilaya de Boumerdes à environ 40 kilomètres à l'est 

d'Alger, est délimitée au nord par la Méditerranée occidentale, au sud par la plaine de la 

Mitidja, à l'est par le Cap Djinet (36°53'N, 3°43'E), et à l'ouest par le Cap Matifou (36°49'N, 

3°13'E). La baie présente une ouverture substantielle vers le nord, s'étendant sur un linéaire 

côtier d'environ 54 kilomètres ce qui facilite la circulation des eaux et permet un meilleur 

drainage de la pollution côtière. La présence remarquable d'un promontoire rocheux, le 
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Rocher Noir, d'une altitude d'environ 100 mètres, constitue une caractéristique topographique 

notable de la région (Figure 8). 

 

Figure 8: Situation géographique de la baie de Zemmouri. 

2.1.3 Baie de Bou Ismail 

La baie de Bou Ismail, également appelée Golfe de Castiglione, est située dans la wilaya de 

Tipaza, à environ 30 km à l'ouest d'Alger. Elle s'étend du promontoire de Ras-Acrata à l'est 

(36°48’N, 2°54′E) au cap du Mont Chenoua à l'ouest (36°37’N, 2°24’E), avec la Méditerranée 

occidentale au nord et la plaine de la Mitidja au sud. Avec une superficie d'environ 350 km², 

la baie possède un linéaire côtier de plus de 60 km et une ouverture d'environ 40 km. Cette 

caractéristique d'ouverture contribue à favoriser une bonne circulation des eaux. La baie est 

divisée en deux parties : une baie à l'est, la baie d'en Djamila, représentant le quart oriental 

d’elle et une grande baie à l'ouest, celle de Bousmail (Figure 9). 

 

Figure 9: Situation géographique de la baie de Bou Ismail. 
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2.2 Conditions météorologiques : Les Précipitations 

La Figure 10présente les cumuls des précipitations mensuelles moyennes pour les stations de 

Baraki, Birmandreis et El Hamiz tout au long de l'année. Les précipitations sont élevées de 

Novembre à Mars, dépassant les 100 mm, avant de diminuer progressivement jusqu'à 

atteindre leur minimum en juillet et août, période correspondante à la saison sèche. Cette 

saisonnalité a un impact direct sur la pollution plastique. En effet, les fortes pluies en début et 

fin d'année entraînent un ruissellement accru, transportant des déchets plastiques depuis les 

zones urbaines vers les cours d'eau et donc vers les eaux côtières. Durant les mois secs, les 

plastiques peuvent s'accumuler sur les sols et sont ensuite déplacés avec la reprise des pluies. 

 

Figure 10 : Les cumuls de précipitations mensuelles moyennes des trois stations : Baraki, Birmandreis, 
El Hamiz. Source : (GAOUAOU&HAMROUCHE, 2022) 

2.3 Réseau hydrographique  

Le réseau hydrographique est un acteur clé dans le transfert des débris plastiques vers les 

milieux marins. À travers le ruissellement des déchets plastiques le long des cours d'eau et des 

rivières, une quantité considérable de plastique est acheminée vers les milieux marins 

constituant un élément majeur dans la contamination des écosystèmes marins. Pour mieux 

comprendre ce phénomène, une attention particulière est portée aux caractéristiques des 

principaux oueds des trois baies (Baie d’Alger, Baie de Zemmouri et Baie de Bou Ismail) 

(Figure 11). Le Tableau 7 résume les informations importantes sur ces cours d'eau. 

 



Zone d’étude 
 

24 

 

 

Figure 11: Carte des réseaux hydrographiques de la zone d’étude. (Source: DOUIBI&FERDI, 2020) 

Des données sur les débits mensuels moyens des oueds El Harrach, El Hamiz, Mazafran et 

Isser, couvrant les périodes de 1983 à 2015, ont été récoltées auprès de l'Agence Nationale 

des Ressources Hydrauliques (ANRH) afin de mieux comprendre le comportement 

hydrologique de ces cours d'eau et leur impact sur le transport des débris plastiques. 

D’après les graphes de la Figure 12, les oueds d’El Harrach, d’El Hamiz, de Mazafran et 

d’Isser connaissent des variations saisonnières significatives, avec des débits maximaux en 

hiver et au début du printemps. En décembre, janvier, février et mars, les débits sont 

particulièrement élevés, atteignant des pics qui indiquent une forte capacité de transport de 

matériaux, y compris des débris plastiques : 

 Oued Isser : un débit moyen de 14,8 m³/s en février 

 Oued Mazafran : un débit moyen de 14,47 m³/s en mars 

 Oued El Harrach : un débit moyen de 10,8 m³/s en février 

 Oued El Hamiz : un débit moyen de 1,3 m³/s en décembre 
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Tableau 7: Les caractéristiques des oueds de la zone d'étude. (Source: DOUIBI&FERDI, 2020: Données 
récoltées entre  1989 et 2019) 

Oued Région/source 

Superficie 

(Km²) -  

Longueur 

(Km) 

Transport solide 

(mm³/an) 

Le taux d’abrasion 

(m³/km³) 

Débit liquide (m³/s) 

Caractéristiques 

Oued Isser 
 
 

 

Baie de Zemmouri (Boumerdes). 
S'écoule du Sud vers le Nord (de Béni 
Amrane à Sidi Ali Messaoud). 
Il est dévié vers l'Est en direction de 
Sidi Mustapha 

4145 km²  
97 km 

4,96mm³/an 
1200m³/km³ 

Caractérisé par une dynamique érosive, 
complexe. 
Classé parmi les cinq principaux 
fleuves d’Alger. 
 

Oued de 

Boumerdes  

Baie de Zemmouri (Boumerdes). 

Passe par la plage de Rocher Noir. 

10,08 km 

 

0,02mm³/an 
550m³/km³ 

 
 

Reçoit de grands affluents provenant du 
bassin versant. 

Responsable du drainage de la plage 
Rocher Noir. 

Oued Corso 
Baie de Zemmouri (Boumerdes). 
Située à 25 km à l'Est d'Alger. 

22,41 km² 
0,11 mm³/an 
1150 m³/km³ 

L’aire de drainage de ce bassin couvre 
100km2. 
Son écoulement moyen annuel est 
évalué à 27mm³, son écoulement annuel 
dans la Méditerranée est évalué à 

20mm³. 

Oued 

Boudouaou 

Baie de Zemmouri (Boumerdes). 
II prend naissance à partir d'Oued 

Keddara et Oued El Haddad. Il se 
termine vers la mer par une basse 
vallée entaillée dans les marnes 
bleues. 

93 km²  
22 km 

0,21 mm³/an 
1830 m³/km³ 

Il draine la partie orientale de l’Atlas 
blidéen. 
L’écoulement annuel moyen de l’Oued 
Boudouaou est évalué à 27mm³. 
L’écoulement annuel moyen dans la 
Méditerranée est estimé 
approximativement à 37mm³. 

Oued 

Réghaia 

Baie de Zemmouri (Boumerdes). 
Il parcourt la partie orientale de la 
pleine de la Metidja. 
 Il traverse la ride sahélienne au Nord, 
au contact de laquelle s’est formé le 
marais de Réghaia pour se heurter en 
aval à un cordon dunaire qui modifie 
son trajet vers l’Est pour enfin se jeter 

dans la mer Méditerranée. 

86 km²  
20 km 

0,02 mm³/an 
210 m³/km³ 

Oued Réghaia sépare les communes de 
Réghaia et de Harraoua en coulant dans 
un bassin versant. 

Oued El 

Hamiz 

Baie d’Alger. 
Il s’écoule d’Ouest en Est au nord de 
l’Algérie. 

315 km²  
60 km 

/ 

La présence du barrage d’El Hamiz 
réduit considérablement ses apports 
solides vers la mer. 
Il draine l’extrémité orientale de Plaine 
de la Mitidja. 

Oued El 

Harrach 

Baie d’Alger. 
 Il s’écoule du Sud vers le Nord à 
travers l’Atlas Blidéen, la Mitidja et 
le Sahel où finalement il se jette à la 
mer. 

1200 km² 5,41 m³/s 

Il reçoit les rejets urbains, industriels et 
agricoles, de ce fait altère toute la 
biodiversité qui y vit, de par sa qualité 
physico-chimique et microbiologique 
très dégradée. 

Oued Beni-

Messous 

Baie de Bou Ismail. 
Il prend naissance au massive de 
Bouzereah et il est alimenté par les 

décharges provenant de Bouzereah, 
Beni-Messous et Chéraga. 
Il débouche dans la baie d’El 
Djamila. 

33 km²  
11 km 

0,245 m³/s 

C’est le réceptacle de toutes les eaux 

usées domestiques et industrielles des 
zones qu’il traverse. 

Oued 

Mazafran 

Baie de Bou Ismail. 
Il prend source au niveau du point de 
rencontre d’Oued Chiffa et Oued Djer 

et il débouche entre Douaouda et 
Zeralda. 

1850 km²  
24 km 

7,566 m³/s 
Le plus important des oueds qui 
déversent dans la baie de Bou Ismail. 

Oued Nador 
Baie de Bou Ismail, et débouche entre 
Tipaza et Mont Chenoua. 

200-300 
km² 

0,89 m³/s 
Il est alimenté par deux oueds qui sont : 
Oued Bourguiga et Oued Merrad. 
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Figure 12: Débits mensuels moyens des oueds (El Harrache, El Hamiz, Mazafranet Isser) d’après les données de l’ANRH. 



Zone d’étude 
 

27 

 

2.4 Les sources de pollution  

2.4.1 Baie d’Alger  

La baie d'Alger est fortement affectée par les activités anthropiques, en raison de : 

- La densité de population estimée à 3 309 896 habitants en 2020 (MTA, 2020a). 

- La présence de quatre zones industrielles (Oued Smar, Sidi Moussa, Rouiba_Reghaia, 

et El Harrach), contribuant à un développement industriel dynamique (Tableau 8). 

- Un réseau routier dense s'étalant sur 2374,3 km composé de 573,3 km de routes 

nationales, 254 km de chemins de wilayas et 1547 km de chemins communaux (MTA, 

2020a). 

- Un aéroport Houari Boumediene et deux infrastructures portuaires : Alger et El Marsa 

(DCA, 2016). Trois autres ports sont compris dans la wilaya d’Alger, à savoir le port 

d’El Djamila, de Rais hamidou et de Sidi Fredj. 

Les eaux des deux oueds, El Hamiz et El Harrach, se déversent dans la baie, avec El Harrach 

transportant principalement des eaux usées non traitées, altérant la qualité de l'eau. Les rejets 

industriels de la cimenterie de Rais Hamidou et les déchets des navires dans le port 

contribuent également à la pollution. De plus, la station de dessalement d'eau de mer d'El-

Hamma génère des saumures qui nuisent aux écosystèmes côtiers. D’après GUENDOUZI 

(2011), ces facteurs ont entraîné une interdiction de la baignade sur 46 plages en 2004, et une 

réduction de la biodiversité marine de 14% a été enregistrée. 

Tableau 8 : Les activités polluantes en baie d’Alger. (Source:PAC, 2006) 

Zone industrielle Unité industrielle Nature de l’activité 

Alger – Port 

COGRAL Filiale ENCG 
HRSA/UP5 

Raffinage des huiles et fabrication de savon 

Centrale thermique Production d’électricité 

COGRAL RSA/UP6 Production d’huile et cosmétique 

Oued El Harrach 

Parfumerie et cosmétique de l’Oasis Fabrication de parfum et cosmétique 

EPBH Fabrication de boissons gazeuses et bières 

ENCP TPIG Transformation de plastique 

Oued Smar 

ENPEC Fabrication d’accumulateurs de démarrage de plomb 

SIAD Production de détergents 

Complexe de levure ERIAD Production de levure 

ENAP Peinture, vernis, diluants et colles 

Aromes d’Algérie Emulsion 10t, essences 3t/an, aromes 2t/an 
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2.4.2 Baie de Zemmouri  

La baie de Zemmouri est réputée pour son activité agricole ainsi que son développement 

industriel et touristique modéré. Elle est donc soumise à une pression anthropique, marquée 

par plusieurs facteurs : 

- Une population dense, passant de 647 389 habitants en 1998 à 960 315 habitants en 

2020, soit un taux de croissance annuel moyen de 02,01% (MICLAT, 2019a). 

- La présence de trois zones industrielles (Laarbatache, Ouled Moussa et Khemis El-

Khechna) (MTA, 2018). 

- Un réseau routier étendu s'étalant sur 1483 km au total, dont 282 km de routes 

nationales, 350 km de chemins de Wilaya et 851 km de chemins communaux (MTA, 

2018). 

- Trois infrastructures portuaires : Dellys, Djinet et Zemmouri El Bahri (MTA, 2018). 

C’est le lieu de déversement de plusieurs oueds, de nature et d'importance variables, 

entraînant des apports divers le long de ses côtes, notamment après le séisme de Boumerdes 

en mai 2003, qui a vu la multiplication des bidonvilles le long du littoral de Boumerdes à 

Zemmouri, accentuant ainsi les sources de pollution marine. 

2.4.3 Baie de Bou Ismail  

La baie de Bou Ismail, reconnue pour son attrait touristique et son importance agricole, est 

impactée par les activités humaines, engendrées par plusieurs facteurs : 

- Une densité de population estimée à 706 054 habitants en décembre 2019, par rapport 

à une estimation antérieure de 591 010 habitants selon le RGPH de 2008, indiquant 

une augmentation de 19,46% (MICLAT, 2019b). 

- La présence de douze zones d'activités dans le parc industriel de la wilaya de Tipaza 

(MTA, 2020b). 

- Un réseau routier dense, totalisant 1 710,565 kilomètres, avec une répartition de 14,4 

% pour les routes nationales, 15,5% pour les chemins de wilaya, 66% pour les 

chemins communaux et 4,1% pour les routes voie express (MICLAT, 2019b). 

- Cinq infrastructures portuaires localisées à :Gouraya, Cherchell, Bouharoun, Khemisti 

et Tipasa (MICLAT, 2019b). 
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De surcroît, la baie est principalement exposée aux rejets domestiques provenant 

majoritairement des agglomérations, des villes côtières et des complexes touristiques se 

déversant directement dans l'environnement sans traitement préalable dans la plupart des cas. 

De plus, les oueds traversant les zones urbaines déversent en mer les eaux de ruissellement 

des terres agricoles ainsi que les effluents urbains et industriels (Figure 13). 

 

Figure 13: Carte des pressions naturelles et anthropiques dans la baie de Bou Ismail. 

(Source : BELKESSA, 2005) 
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3 MATERIELS ET METHODES 

La détection de la pollution plastique dans le littoral Algérois est une thématique actuelle et 

cruciale, étant donné que les méthodes de détection sont relativement récentes, émergeant 

principalement après 2019 selon la documentation disponible (Tableau 9). Ces méthodes sont 

spécifiques aux différents types de plastiques, s'appuyant sur leurs propriétés spectrales 

distinctes pour les identifier. En outre, une gamme de technologies de télédétection est à 

disposition, comprenant des approches optiques, radar, et autres, comme illustré dans le 

Tableau 9. L'objectif de cette étude est de savoir si on peut détecter, ou non, la présence 

potentielle des déchets marins flottants, notamment le plastique, le long du littoral Algérois. 

La télédétection optique a été privilégiée dans le cadre de cette étude. Ce chapitre présente en 

détail les méthodes et les outils utilisés. 

3.1 Logiciels utilisés  

3.1.1 SNAP  

Un outil d'analyse des observations de la Terre en accès libre, SNAP permet d'accéder à des 

données environnementales issues de diverses missions de télédétection, notamment Sentinel-

1, Sentinel-2 et Sentinel-3 du Programme Copernicus de l'Union Européenne, ainsi que des 

missions d'exploration de la Terre de l'ESA telles que le satellite SMOS et des missions de 

tiers. Il facilite l'exploration, l'analyse et le traitement des données de télédétection, soutenant 

la recherche scientifique, l'éducation, la formation et les applications opérationnelles 

(EOPORTAL, 2022). 

3.1.2 ArcGIS  

ArcGIS constitue un système intégré qui assure la collecte, l'organisation, la gestion, l'analyse, 

la communication et la diffusion des données géographiques. En tant que plateforme 

prédominante dans le développement et l'utilisation des systèmes d'information géographique 

(SIG) à l'échelle mondiale, ArcGIS est largement adopté par une communauté mondiale pour 

mettre en valeur les connaissances géographiques au service du gouvernement, des 

entreprises, de la science, de l'éducation et des médias (ARCGIS RESOURCES, 2010).
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Tableau 9: Méthodes de détection du plastique existantes. 

Types de technologie Types spectraux 
Bandeplastiquedétectée/ 

modèleouméthode 
Zone de surveillance Type d’échantillon Taille d’échantillon Précision 

1. Télédétection par satellite 

LS-8, S-2, Planet 
(KIKAKIet al., 2020) 

Multispectral 
Bande bleue, indice du satellite/ réseau 
de neurone 

Terre, rivière 
plastique, pneus, 
déchetterie 

Nd 82-86% 

Sentinel-2 
(TOPOUZELISet al., 2020) 

(THEMISTOCLEOUSet al., 

2020) 

(LAVENDER, 2022) 

 
Rouge, NIR, SWIR, indice du satellite/ 
filtrage adapté, ML (Machine 
Learning) 

Rivière, plage, océan PET, PEBD 1-10 m 
58- 90 % 
25 % des 
pixels 

PRISMA 
(KREMEZIet al., 2021) 

(TAGGIOet al., 2022) 

Hyperspectral Non-supervisé, indice du satellite, ML Plage, océan 
PEHD, PET, PS, PEHD + 

PET + PS 
0,6-5,1 m 96% 

Sentinel-1 
(SIMPSONet al., 2022) 

Radar à Synthèse 
d'Ouverture 

Polarisation VH/ différences de 
rétrodiffusion 

Rivière accumulation de plastique Nd 85 à 95% 

2. Télédétection aérienne 

Caméra 
Pushbroom 
(FREITASet al., 2022) 

Hyperspectral nd/ deeplearning (ZSL) Océan PE, LDPE, corde 2,5-10 m 98,71 % 

3. Véhicules aériens sans pilote 

Caméra multispectrale 
(LUOet al., 2022) 

(TADDIAet al., 2021) 

(MAHARJANet al., 2022) 

Caméra DSM, NDVI/ ML, deep learning Rivière PET, PEBD, PU, PS 0,25-80 cm 65-86% 

Caméra pushbroom 
(BALSIet al., 2021) 

Hyperspectral NIR, SWIR/ discriminant linéaire Plage, océan PE, PET Nd nd 

4. Capteurs statiques 

Antenne Radar 
(SERAFINO&BIANCO, 2021) 

Signal Radar Bande X/ surface équivalente Radar Océan PET, PEBD, PU, PS 0,3-1 m nd 
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3.1.3 ENVI 

Le logiciel ENVI représente une solution complète et commerciale pour la visualisation ainsi 

que le traitement d'images dérivées de la télédétection. Il englobe l'ensemble des méthodes 

essentielles de traitement d'images, incluant la correction géométrique et radiométrique, la 

classification, ainsi que la mise en page cartographique (ESRI, 2023). 

3.2 Méthode 1 : Détection des débris macroplastiques par des indices spectraux 

3.2.1 Acquisition des données  

3.2.1.1 Définition des zones et périodes d’étude  

Les zones d'étude sélectionnées comprennent la baie d'Alger, la baie de Zemmouri et la baie 

de Bou Ismail. La délimitation de la zone d'étude repose sur les contours géographiques de 

ces trois baies ainsi que sur ceux des images satellitaires téléchargées. Elles sont situées 

respectivement entre les latitudes 36°30'N et 37°00'N, et les longitudes 2°18'E et 3°48'E. 

Concernant les périodes d'étude, il est pertinent, pour cette étude portant sur l'année 2023-

2024, de couvrir chaque saison afin d'évaluer l'influence éventuelle des variations saisonnières 

sur la présence potentielle des débris plastiques. La superficie totale de la zone d'étude est de 

3940 km². 

3.2.1.2 Téléchargement des images satellitaires  

Les images satellites Sentinel-2 MSI niveau 1C, correspondantes aux zones et périodes 

d’étude, ont été téléchargées via le centre d’accès libre de Copernicus et de l’ESA 

(https://dataspace.copernicus.eu). La sélection des images s’est faîte en fonction de la 

couverture nuageuse la plus faible afin de garantir la qualité des données (Tableau 10). Il a été 

nécessaire de recourir à deux images pour couvrir intégralement la zone d'étude lors de 

chaque période considérée. 

Tableau 10: Liste des images Sentinel-2 capturées au-dessus des trois baies. 

Nom du fichier de l'image Date Saison 

S2B_MSIL1C_20230325T102649_N0509_R108_T31SEA

_20230325T122948.SAFE 
25/03/2023 Printemps 

S2B_MSIL1C_20230325T102649_N0509_R108_T31DA_
20230325T122948.SAFE 

25/03/2023 Printemps 

S2B_MSIL1C_20230812T102609_N0509_R108_T31SEA
_20230812T141200.SAFE 

12/08/2023 Été 

S2B_MSIL1C_20230812T102609_N0509_R108_T31DA_

20230812T141200.SAFE 
12/08/2023 Été 

https://dataspace.copernicus.eu/
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Nom du fichier de l'image Date Saison 

S2A_MSIL1C_20231006T102911_N0509_R108_T31SEA
_20231006T141008.SAFE 

06/10/2023 Automne 

S2A_MSIL1C_20231006T102911_N0509_R108_T31DA_
20231006T141008.SAFE 

06/10/2023 Automne 

S2A_MSIL1C_20240203T103231_N0510_R108_T31SEA

_20240203T123412.SAFE 
03/02/2024 Hiver 

S2A_MSIL1C_20240203T103231_N0510_R108_T31DA_
20240203T123412.SAFE 

03/02/2024 Hiver 

S2B_MSIL2A_20230325T102649_N0509_R108_T31SEA
_20230325T133051.SAFE 

25/03/2023 Printemps 

S2B_MSIL2A_20230812T102609_N0509_R108_T31SEA
_20230812T150144.SAFE 

12/08/2023 Été 

S2A_MSIL2A_20231006T102911_N0509_R108_T31SEA
_20231006T162956.SAFE 

06/10/2023 Automne 

S2A_MSIL2A_20240203T103231_N0510_R108_T31SEA
_20240203T143851.SAFE 

03/02/2024 Hiver 

 

3.2.2 Prétraitements des images Sentinel-2  

L’ouverture des images s’est faite via le logiciel SNAP. 

 File > Import > Optical Sensors> Sentinel-2 

3.2.2.1 Correction atmosphérique  

Les données de Niveau 1C ont été soumises à une correction atmosphérique6 en utilisant 

Sen2Cor, un algorithme de l'Agence Spatiale Européenne (ESA) disponible dans SNAP 

(Figure 14). Dans la littérature, les chercheurs ont généralement recours à Sen2Cor 

(DAMAYANTIet al., 2022 ; LAVENDER, 2022) ou à l’ACOLITE (KIKAKIet al., 2020 ; MATHIS, 

2021 ; SANNIGRAHIet al., 2021 ; TOPOUZELISet al., 2020) pour la correction atmosphérique 

des images Sentinel-2. Sen2Cor est un algorithme de l'Agence Spatiale Européenne (ESA) 

pour la correction atmosphérique des images Sentinel-2, qui corrige l'effet atmosphérique des 

produits Sentinel-2 de Niveau 1C en Top of Atmosphere (TOA) vers un produit de réflectance 

de Niveau 2A en Bottom of Atmosphere (BOA) (SENTINEL ONLINE, 2020). En revanche, 

ACOLITE est un logiciel open-source de correction atmosphérique et de suppression des 

reflets du soleil, initialement développé pour le traitement des scènes aquatiques dans les eaux 

turbides (TOPOUZELISet al., 2020)(Figure 15). Après une évaluation comparative des deux 

méthodes, Sen2Cor a été choisi dans cette étude plutôt que l'algorithme ACOLITE, en raison 

des résultats meilleurs obtenus lors du calcul des indices. 

 Tools > Plugins > Available Plugins > SEN2COR280 Processor > Install 

                                                
6La correction atmosphérique est le processus permettant d'éliminer les effets de diffusion et d'absorption de 
l'atmosphère sur les valeurs de réflectance des images prises par des capteurs satellites ou aéroportés. 
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 Optical > Thematic Land Processing > SEN2COR280 

 

Figure 14: Interface de l'outil Sen2Cor. 

 

Figure 15: Interface de l'outil ACOLITE. 

3.2.2.2 Extraction de la zone d’étude (SpacialSubset)  

Ce processus consiste à délimiter notre zone d'étude par le découpage des différentes images, 

réduisant ainsi leurs tailles et améliorant les performances en termes de vitesse de traitement. 

 Raster >Subset 
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3.2.2.3 Rééchantionnage (Resampling)  

Un rééchantillonnage des bandes spectrales nécessaires à notre étude a été effectué pour 

uniformiser la résolution spatiale de ces bandes à 10 mètres. 

 Raster >Geometric>Resampling 

3.2.2.4 Reprojection  

Dans cette étude, une reprojection géodésique a été choisie afin de convertir les données des 

images satellitaires entre différents systèmes de coordonnées. Cette méthode assure une 

conversion précise entre les coordonnées géographiques et cartésiennes, en prenant en compte 

la courbure de la surface terrestre.  

 Raster >Geometric> Reprojection 

3.2.2.5 Mosaïquage (Mosaicking)  

Un mosaïquage a été effectué pour obtenir une représentation complète et cohérente de la 

zone d’étude (Figure 16). 

 Raster >Geometric>Mosaicking 

 

Figure 16: Résultat du Mosaïquage des trois baies. 

3.2.3 Traitement des images Sentinel-2  

Les zones d'accumulation de déchets plastiques ont été identifiées grâce à l'application 

d'indices spectraux spécifiques dans la région étudiée. Pour repérer les débris plastiques 

potentiels en mer, deux indices spectraux ont été utilisés dans cette étude, notamment l'indice 
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des débris flottants (FDI) et l'indice de végétation à différence normalisée (NDVI) 

(THEMISTOCLEOUSet al., 2020). 

3.2.3.1 Calcul de l'Indice des Débris Flottants (FDI)  

D’après les recherches de WILCOXet al. (2015), l'Indice des Débris Flottants (FDI) est efficace 

pour détecter les débris plastiques potentiels en fonction de la quantité de matériau présente 

dans un pixel donné. Selon cette étude, le FDI permet d'obtenir une signature spectrale 

distinctive pour les matériaux flottants et l'eau (SANNIGRAHIet al., 2021). 

𝐹𝐷𝐼 = 𝑅rs𝑁𝐼𝑅 − 𝑅𝑟𝑠′𝑁𝐼𝑅...(I) 

𝑅𝑟𝑠′𝑁𝐼𝑅 = 𝑅𝑟𝑠𝑅𝐸2 + (𝑅𝑟𝑠𝑆𝑊𝐼𝑅1 − 𝑅𝑟𝑠𝑅𝐸2) ∗ ((𝜆𝐵8 − 𝜆𝐵4) /(𝜆𝐵11 − 𝜆𝐵4)) ∗ 10…(II) 

Où 𝑅𝑟𝑠 est la réflectance de la bande spectrale du NIR (B8), Red Edge-2 (B6), et SWIR-1 

(B11). L'indice utilise également la longueur d'onde centrale des bandes B8 (λB8, 842 nm), 

B4 (λB4, 665 nm), et B11 (λB11, 1610 nm). 

Il se traduit donc comme suit : 

𝐹𝐷𝐼 = 𝐵8 − (𝐵6 + (𝐵11 − 𝐵6) ∗ (
842−665

1610−665
) ∗ 10)…(III) 

3.2.3.2 Calcul de l'Indice de Végétation à Différence Normalisée (NDVI)  

Selon SANNIGRAHIet al. (2021), l’Indice de Végétation à Différence Normalisée (NDVI) est 

présenté comme une mesure de la verdure de la végétation. La végétation a la particularité 

d'absorber fortement la lumière rouge et de réfléchir abondamment la lumière proche 

infrarouge, ce qui permet de l'identifier aisément. Les valeurs de NDVI tendent à être proches 

de zéro pour les débris plastiques en mer (BIERMANNet al., 2020). L'équation du NDVI a été 

élaborée pour identifier les caractéristiques spectrales, comme le décrit l’équation suivante : 

𝑁𝐷𝑉𝐼 = (𝑅𝑟𝑠𝑁𝐼𝑅 − 𝑅𝑟𝑠𝑅𝐸𝐷)/(𝑅𝑟𝑠𝑁𝐼𝑅 + 𝑅𝑟𝑠𝑅𝐸𝐷)…(IV) 

Pour les bandes spectrales du Sentinel 2, l’indice se traduit comme suit : 

𝑁𝐷𝑉𝐼 = (𝐵8 − 𝐵4)/(𝐵8 − 𝐵4)…(V) 

3.2.3.3 Seuillage 

La méthodologie suivie se base sur la possibilité de réaliser une classification à l'aide du 

logiciel SNAP en utilisant une "cible plastique de référence" stable et suffisamment grande 

pour couvrir la totalité d'un pixel. Cependant, aucun échantillon approprié n'a pu être localisé 
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sur Google Earth. Par conséquent, une approche alternative a été adoptée consistant à créer un 

masque basé sur les seuils définis par MATHIS (2021). Selon ses recherches, le plastique était 

considéré potentiellement présent lorsque la réflectance de l'Indice de Végétation de 

Différence Normalisée était comprise entre 0,02 et 0,23, et lorsque la réflectance de l'Indice 

des Débris Flottants était située entre 0,018 et 0,068.  

 Réalisation du masque : Mask manager > f(x) > OK 

 Calcul de la superficie : Raster >Masks> Mask Area… 

3.2.4 Cartographie 

Dans le cadre de cette étude, la cartographie spatiale des débris plastiques a été jugée 

essentielle pour comprendre leur répartition spatiale dans la zone d'étude. Pour ce faire, une 

digitalisation de la côte de la zone d'étude a été effectuée sur le logiciel SNAP. Une fois les 

résultats ont été importés dans ArcMap sous forme d’un shapefile-point, les débris potentiels 

de plastique, obtenus après le masque, ont été superposés sur la carte. À partir de ces données, 

des cartes ont été générées pour les quatre saisons. 

3.2.5 Validation et vérification des résultats 

Afin d’évaluer le niveau de précision des indices qui ont été appliqués pour détecter les débris 

plastiques marins dans les étendues d'eau côtières, la validation s'est déroulée par des 

vérifications visuelles à l'aide de Google Earth Pro à la même date que les données Sentinel-2. 

Les éléments supplémentaires identifiés à la surface de l'eau, tels que les navires/bateaux, les 

rochers et les fermes aquacoles, ont été exclus de l'analyse. Cette approche a été adoptée en 

raison de l'absence de données in-situ disponibles pour la confirmation (DAMAYANTIet al., 

2022).  

Une validation supplémentaire de la méthodologie utilisée a été entreprise en la reproduisant 

sur une image Sentinel-2 capturée le 09/10/2017, couvrant les îles de la Baie et le golfe du 

Honduras. Le choix de cette zone géographique a été motivé par la disponibilité des données 

in-situ collectées tout au long du mois (KIKAKIet al., 2020). Les indices calculés ont identifié 

de manière précise la zone où les débris de plastique ont été observés sur le terrain, 

confirmant ainsi la fiabilité de notre approche. 
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3.3 Méthode 2 : Détection de la contamination plastique par le script de Copernicus 

3.3.1 Description générale du script 

Un script développé par MELYKUTI (2019) a été spécialement conçu pour traiter les images de 

niveau 1C de Sentinel-2 (Annexe 2)7. Son objectif est de distinguer les zones terrestres des 

zones aquatiques en utilisant l'Indice de l'Eau Normalisée (NDWI). Il devrait donc identifier 

la présence de plastique dans l'eau selon une échelle de couleur allant du bleu foncé au jaune, 

le bleu foncé indiquant l'absence de contamination. L’indice NDWI se traduit comme suit :  

𝑁𝐷𝑊𝐼 = (𝐵3 − 𝐵8)/(𝐵3 + 𝐵8)…(VI) 

Le processus de développement du script a impliqué des tests de différentes méthodes 

d'apprentissage automatique. Pour l'entraînement, 115 pixels ont été étiquetés, dont 13 

présentaient du plastique et 102 n'en présentaient pas. Toutes les 12 bandes (B1-B12) 

atteignant le fond de l'atmosphère ont été utilisées comme variables explicatives. Les données 

de marquage du plastique proviennent d'une étude où trois cadres de 10mx10m remplis de 

matériau plastique ont été placés dans la mer pour un survol unique des satellites Sentinel-1 et 

-2. 

Le développement du script a également abouti à plusieurs réalisations notables :  

 Une fonctionnalité écrite en Python3, mise en œuvre dans un notebook Jupyter, 

permettant de sélectionner et de visualiser les pixels sélectionnés. Leurs valeurs dans 

les 12 bandes sont extraites ;  

 Une implémentation en Python3 utilisant uniquement des opérations de base pour 

évaluer les modèles d'apprentissage automatique ajustés à partir de Scikit-Learn, testés 

par rapport aux implémentations Scikit-Learn eux-mêmes ;  

 La transformation de l’implémentation de l’auteur pour chaque modèle en code 

JavaScript pour Sentinel Hub par un code Python3  

 La création d'un compartiment de stockage Google Cloud Storage pour héberger 

divers scripts. 

                                                
7https://custom-scripts.sentinel-hub.com/sentinel-2/ocean_plastic_detector/ 

https://custom-scripts.sentinel-hub.com/sentinel-2/ocean_plastic_detector/


Matériels et méthodes 
 

40 

 

3.3.2 Téléchargement des images satellitaires 

La sélection et le téléchargement des images satellites Sentinel-2 MSI de niveau 1 ont été 

effectués selon une approche similaire à celle décrite pour la méthode 1. Ce processus a été 

réalisé en utilisant le centre d'accès libre de Copernicus et de l’ESA 

(https://dataspace.copernicus.eu). Toutefois, une étape supplémentaire a été ajoutée consistant 

à intégrer le script développé par MELYKUTI (2019) avant le téléchargement des images.  

Afin de tirer pleinement parti des données disponibles et de pousser plus loin l’étude, 

plusieurs images couvrant la période 2023-2024 ont été téléchargées. Cette démarche permet 

d'explorer plus en détail la répartition spatio-temporelle de la contamination plastique 

(Tableau 11). 

Tableau 11: Liste des images téléchargées après intégration du script. 

Nom du fichier de l'image Date Saison 

2023-02-28-00_00_2023-03-30-23_59_Sentinel-

2_L1C_Custom_script.kmz 
03/30/2023 Printemps 

2023-05-18-00_00_2023-06-18-23_59_Sentinel-
2_L1C_Custom_script.kmz 

18/06/2023 Printemps 

2023-05-28-00_00_2023-06-28-23_59_Sentinel-
2_L1C_Custom_script.kmz 

28/06/2023 Été 

2023-06-23-00_00_2023-07-23-23_59_Sentinel-
2_L1C_Custom_script.kmz 

23/07/2023 Été 

2023-06-26-00_00_2023-07-26-23_59_Sentinel-
2_L1C_Custom_script.kmz 

26/07/2023 Été 

2023-07-07-00_00_2023-08-07-23_59_Sentinel-
2_L1C_Custom_script.kmz 

27/08/2023 Été 

2023-07-12-00_00_2023-08-12-23_59_Sentinel-
2_L1C_Custom_script.kmz 

12/08/2023 Été 

2023-09-06-00_00_2023-10-06-23_59_Sentinel-
2_L1C_Custom_script.kmz 

06/10/2023 Automne 

2023-10-25-00_00_2023-11-25-23_59_Sentinel-
2_L1C_Custom_script.kmz 

25/11/2023 Automne 

2023-11-10-00_00_2023-12-10-23_59_Sentinel-
2_L1C_Custom_script.kmz 

10/12/2023 Hiver 

2024-01-13-00_00_2024-02-13-23_59_Sentinel-
2_L1C_Custom_script.kmz 

13/02/2024 Hiver 

2024-03-18-00_00_2024-04-18-23_59_Sentinel-
2_L1C_Custom_script.kmz 

18/04/2024 Printemps 

2024-04-03-00_00_2024-05-03-23_59_Sentinel-
2_L1C_Custom_script.kmz 

03/05/2024 Printemps 

https://dataspace.copernicus.eu/


Matériels et méthodes 
 

41 

 

3.3.3 Traitement et cartographie des images du script 

Afin d’ouvrir les images téléchargées du script sur ENVI, une conversion au format ENVI a 

été effectuée via ArcMap. Par la suite, une classification supervisée des images dans ENVI a 

été réalisée par l’utilisation de l’algorithme Maximum Likelihood, en distinguant une classe 

soupçonnant la contamination plastique et une autre ne présentant aucune suspicion de 

contamination. Cette classification a impliqué la création d'une région d'intérêt (ROI) pour 

chaque classe et la sélection d'échantillons représentatifs. Pour le découpage de la zone 

d'étude, un masque "Zone d'étude" est appliqué. Les étapes suivantes ont été suivies: 

1- Sur ArcMap: 

 Click droit > Data > Export Data…>Format ENVI 

2- Sur ENVI : 

 ROI > New ROI  

 Toolbox > Classification > Supervised Classification > Maximum Likelihood 

Classification 

 Toolbox > Regions Of Interest > Subset data from ROI 

Il convient de noter que la classification a été effectuée exclusivement sur les images ayant la 

même date que notre période d'étude. Cette approche a été adoptée afin de garantir la 

cohérence temporelle des données et de permettre une comparaison précise des résultats. Les 

autres images provenant de différentes dates ont été conservées pour une analyse spatio-

temporelle ultérieure, afin d'évaluer l'évolution de la contamination plastique dans la région 

d'étude. De plus, pour chaque image téléchargée, une carte a été générée sur ArcMap dans le 

but de faciliter cette analyse spatio-temporelle. 

3.4 Etude de l’occupation du sol  

Afin d'identifier les sources potentielles des débris plastiques flottants et d'interpréter les 

résultats de la détection de manière plus précise et contextualisée, une étude de l'occupation 

du sol dans les wilayas d'Alger, de Boumerdes et de Tipaza a été menée. Cette étude fournit 

un cadre spatial permettant de relier les observations aux activités anthropiques, afin de mieux 

comprendre comment ces dernières peuvent contribuer à la présence de déchets plastiques. 

Pour ce faire, nous avons opté pour une classification supervisée en utilisant le logiciel ENVI. 
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3.4.1 Acquisition des données 

Les images satellitaires Sentinel-2 MSI de niveau 2A utilisées pour l'étude de l'occupation du 

sol ont été téléchargées via le centre d'accès libre de Copernicus et de l'ESA 

(https://dataspace.copernicus.eu). La date des images sélectionnées correspond à celle choisie 

pour l’image du printemps, afin de bénéficier de la couverture nuageuse la plus faible. Trois 

images ont été nécessaires pour couvrir intégralement les trois wilayas d'Alger, Boumerdes et 

Tipaza (Tableau 12). 

Tableau 12:Liste des images Sentinel-2 capturées au-dessus des trois wilayas. 

Nom du fichier de l'image 

S2B_MSIL2A_20230325T102649_N0509_R108_T31SEA_20230325T133051.SAFE 

S2B_MSIL2A_20230325T102649_N0509_R108_T31SDA_20230325T133051.SAFE 

S2B_MSIL2A_20230328T103639_N0509_R008_T31SCA_20230328T134002.SAFE 

 

3.4.2 Prétraitement des images Sentinel-2 

3.4.2.1 Empilement des bandes (Layer stacking)  

Le layer stacking permet de regrouper plusieurs bandes en une seule image multispectrale, 

simplifiant ainsi les manipulations ultérieures. 

 Toolbox > Raster Management > Layer Stacking 

3.4.2.2 Resampling-Reprojection-Mosaiking 

Après avoir effectué un rééchantillonnage à une résolution spatiale de 10 mètres et une 

reprojection géodésique, un mosaïquage a été réalisé pour obtenir une représentation complète 

et cohérente de la wilaya de Tipaza (Figure 17). 

 Raster >Geometric>Resampling 

 Raster >Geometric> Reprojection 

 Raster >Geometric>Mosaicking 

https://dataspace.copernicus.eu/
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Figure 17 : Résultat du Mosaïquage de la wilaya de Tipaza. 

3.4.2.3 Découpage de l’image 

Pour extraire uniquement les trois wilayas, les images utilisées ont été découpées en fonction 

d'un vecteur représentant les limites administratives de ces dernières.  

 Toolbox > Regions Of Interest > Subset data from ROIs 

3.4.3 Traitement des images Sentinel-2 

3.4.3.1 Sélection des régions d’intérêts (ROI) 

La sélection des régions d'intérêt implique de choisir au moins 20 pixels représentatifs sur le 

plan spectral dans chaque ROI. Ces ROIs sont définies à l'écran en numérisant les 

pixels/polygones pour chaque classe spectrale. L'extraction automatique des valeurs de pixels 

contenues à l'intérieur de ces dernières ainsi que le calcul de leur moyenne et de leur écart-

type, permettront de générer la signature spectrale de chaque classe à partir des bandes 

sélectionnées des images Sentinel-2. Cinq classes ont donc été choisies : Eau, sols nus, terres 

agricoles, urbanisation et végétation, comme indiquées dans le Tableau 13. 

Tableau 13 :  Nombre des échantillons de chaque classe. 

Classes Alger  Tipaza Boumerdes 

Eau 31 68 95 

Sols nus 119 41 88 

Terres agricoles 334 100 100 

Urbanisation 569 110 111 

Végétation 146 103 101 
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3.4.3.2 Classification par l’algorithme du Maximum Likelihood 

La méthode de classification supervisée par la procédure du maximum de vraisemblance 

implique de comparer la signature spectrale de chaque pixel dans les bandes sélectionnées 

avec celles des régions d'intérêts, puis d'assigner chaque pixel à la classe dont la signature 

spectrale est la plus similaire (DERDJINI, 2017). 

 Toolbox > Classification > Supervised Classification > Maximum Likelihood 

Classification 

3.4.4 Cartographie 

Une fois la classification terminée, les résultats sont importés dans ArcMap sous format 

ENVI, puis un calcul des superficies et des pourcentages de chaque classe est effectué. A 

partir de ces données, des cartes ont été générées pour les trois wilayas dans le but d'une 

analyse ultérieure de l'occupation du sol. Pour ce faire, les étapes suivantes ont été suivies : 

 Conversion de l’image raster en vecteur : 

ArcToolbox> Conversion tools > From Raster > Raster to Polygon 

 Fusionnement des classes: 

Geoprossessing> Dissolve  

 Calcul des superficies de chaque classe:CalculateGeometry 

Pour calculer les superficies et pourcentages de chaque classe dans les communes côtières des 

trois wilayas, les étapes suivantes ont été réalisées : 

 Découpage du vecteur de la classification supervisée selon celui des communes 

côtières : Geoprocessing> Clip  

 Calcul de l’union géométrique de la classification découpéeetdu vecteur des 

communes côtières : Geoprocessing> Union  

 Calcul des superficies et des pourcentages  
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4 RESULTATS ET DISCUSSION 

Les débris plastiques connaissent une augmentation rapide dans les environnements côtiers et 

océaniques, soulignant le besoin urgent de suivi continu et de surveillance, ainsi que la mise 

en œuvre de mesures préventives. Cette étude examine l'efficacité du satellite Sentinel-2 dans 

la surveillance des débris plastiques, en se concentrant sur le littoral Algérois comme zone 

d'étude. En parallèle, elle propose une analyse critique de la gestion actuelle des déchets 

marins par les textes juridiques, accompagnée de recommandations spécifiques pour une 

gestion durable des déchets plastiques en Algérie. Ce chapitre présente les résultats de la 

présente étude ainsi que leur interprétation. 

4.1 Méthode 1 : Détection des débris macroplastiques par des indices spectraux 

4.1.1 Identification des débris plastiques 

Le premier élément à noter est que la détection de pixels de plastique a été réalisée avec 

succès à partir des images satellitaires Sentinel-2 A et B de niveau 2. Non seulement les 

matériaux plastiques ont pu être détectés, mais également d'autres matériaux flottants tels que 

des bateaux, des navires, des fermes aquacoles, etc. Après vérification, le nombre de pixels de 

plastique a été limité à 26 pixels. 

Suite à l'analyse de l'ensemble des images satellitaires couvrant les zones et la période d'étude, 

les résultats du Tableau 14 ont été obtenus. Par la suite, la surface en mètres carrés 

correspondant au nombre de pixels de plastique suspects a été estimée (chaque pixel 

représentant 100 m² de plastique), ainsi que leur masse (Tableau 15). Enfin, pour mieux 

visualiser la répartition spatio-temporelle du plastique dans les zones d'étude, des cartes ont 

été élaborées pour chaque saison (Figure 18). 
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Tableau 14: Tableau récapitulatif du nombre de pixels de plastique trouvé par image satellitaire. 

Zone d’étude 
Printemps 

(25/03/2023) 

Été 

(12/08/2023) 

Automne 

(06/10/2023) 

Hiver 

(03/02/2024) 

Nombre de 

pixels 

plastiques 

suspects total 

Baie d’Alger 0 0 0 3 3 

Baie de 

Zemmouri 
3 2 9 0 14 

Baie de Bou 

Ismail 
2 2 2 3 9 

Nombre de pixels 

plastiques 

suspects total 

5 4 11 6  

 

 

Tableau 15: Estimation de la surface et la masse du plastique détecté. 

Saison 
Baie d’Alger  

(m²) 

Baie de Zemmouri 

(m²) 

Baie de Bou Ismail 

(m²) 

Superficie totale 

(m²) 

Printemps 

(25/03/2023) 
0 300 200 500 

Été (12/08/2023) 0 200 200 400 

Automne 

(06/10/2023) 
0 900 200 1100 

Hiver 

(03/02/2024) 
300 0 300 600 

Masse de 

plastique (kg) 
1500 7000 4500 13 000 

Lors du calcul du poids du plastique, l'échelle utilisée est celle de KIKAKIet al. (2020), qui équivaut à une masse plastique de 

5000 tonnes/km², soit 5 kg/m². 
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Figure 18: Cartes représentant la répartition des débris plastiques potentiels pour chaque saison. 
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La présence de déchets marins flottants dans la zone d’étude au niveau de la baie d’Alger 

devrait être la plus conséquente vu l’activité industrielle importante au niveau de la baie et sa 

morphologie semi-circulaire. Pourtant, c’est la zone où le moins de pixels de plastique 

suspects ont été détectés (3 pixels), selon la définition restrictive et où la part de la surface de 

plastique estimée par rapport à la surface de mer de l’image est la moins élevée. Cela pourrait 

être lié à l'efficacité des mesures de gestion des déchets mises en place dans la wilaya ainsi 

que le traitement des eaux usées. De plus, le courant algérien, qui longe la côte d'ouest en est, 

pourrait également empêcher l'accumulation de plastique sur les côtes en entraînant les débris 

vers le large. 

La présence de déchets marins flottants dans la baie de Zemmouri est cependant la plus élevée 

(14 pixels), avec une accumulation significative près de l'embouchure de l'oued Isser durant le 

printemps, l'été et l'automne. Cette situation pourrait s'expliquer par une quantité importante 

de plastique charriée par cet oued ainsi que par l’exposition aux courants marins et aux vents, 

qui favoriseraient l'accumulation de débris plastiques flottants à cet endroit. De plus, la baie 

de Zemmouri est moins développée sur le plan industriel et urbain, d’où probablement une 

réduction des mesures de gestion des déchets et augmentation de la quantité de débris 

plastiques rejetés dans l'environnement marin sans traitement. 

Au niveau de la baie de Bou Ismail, bien que la présence de déchets marins flottants soit 

inférieure à celle détectée dans la baie de Zemmouri (9 pixels), elle dépasse celle observée 

dans la baie d'Alger. Ça pourrait être renvoyé à l’influence de la baie de Bou Ismail par les 

courants marins et aux vents qui favoriseraient l'accumulation de débris plastiques flottants en 

ces endroits. De plus, les activités industrielles et surtout touristiques, dues à la présence de 

nombreuses plages dans les deux baies de Zemmouri et de Bou Ismail par rapport à celle 

d'Alger, contribuent également à la pollution plastique. 

Les variations saisonnières dans la détection des débris plastiques par satellite sont aussi 

importantes à noter(Tableau 15). 

Au printemps, la détection de 500 m² de débris plastiques pourrait être attribuée à plusieurs 

facteurs. Cette période est caractérisée par un afflux potentiel de visiteurs sur les côtes pour 

les vacances, ce qui pourrait entraîner une augmentation des déchets plastiques rejetés dans 

l'environnement côtier. De plus, le printemps est également associé à des conditions 

météorologiques plus clémentes, favorisant ainsi les activités de navigation et de pêche, ce qui 

pourrait contribuer à l'accumulation de débris plastiques en mer. 
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En été, bien que la détection de 400 m² de débris plastiques soit légèrement inférieure, cela 

pourrait encore refléter une activité côtière accrue due aux vacances estivales. Les plages et 

les zones côtières sont souvent plus fréquentées pendant cette période, ce qui peut conduire à 

une augmentation des déchets plastiques abandonnés ou échoués. De plus, il est important de 

noter que durant l’été, les plages sont également soumises à des opérations de nettoyage plus 

fréquentes en prévision de l'arrivée des estivants, contrairement au printemps où ces activités 

d'entretien sont moins courantes. Ainsi, il est possible que cette intensification des efforts de 

nettoyage contribue à la réduction de la quantité de plastique détectée. 

En automne, la détection de 1100 m² de débris plastiques est attribuée aux conditions 

océaniques et météorologiques variables. Cette saison est caractérisée par des tempêtes plus 

fréquentes et des courants marins changeants, ce qui peut entraîner une concentration de 

débris plastiques dans certaines zones côtières. 

Enfin, en hiver, bien que la détection de 600 m² de débris plastiques soit légèrement inférieure 

à celle de l'automne, cela pourrait être dû aux conditions météorologiques plus agitées. Les 

tempêtes hivernales et les vents forts peuvent contribuer à la dispersion des débris plastiques, 

les éloignant potentiellement des zones côtières. 

Selon la base de données de TheOceanCleanup, la quantité de plastique émise dans la baie 

d'Alger, la baie de Bou Ismail et la baie de Zemmouri est estimée à environ 900 000, 330 000 

et 250 000 kilogrammes par an, respectivement. Nos observations révèlent les chiffres 

journaliers suivants: une couverture plastique de 300 m² dans la baie d'Alger, estimée à 1500 

kg, 900 m² dans la baie de Bou Ismail, estimée à 7000 kg, et 1400 m² dans la baie de 

Zemmouri, estimée à 4500 kg (Tableau 15). Une comparaison directe entre ces valeurs n’est 

pas possible. Néanmoins, il est important de noter les différences méthodologiques suivantes : 

 Les méthodologies de collecte de données et de calcul utilisées dans notre étude 

diffèrent de celles de la base de données de TheOceanCleanup, ce qui peut conduire à 

des résultats divergents. 

 Les chiffres annuels fournis par TheOceanCleanup peuvent représenter une moyenne 

sur plusieurs années, tandis que nos estimations sont basées sur des observations 

ponctuelles et journalières pour chaque saison. 

 Les conditions environnementales telles que les courants marins, les marées et les 

pratiques de gestion des déchets peuvent influencer la distribution et la concentration 
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du plastique dans notre zone d'étude, ce qui peut expliquer les différences entre les 

données estimées et observées. 

 Une limitation dans la méthodologie, notamment la résolution spatiale de 10 mètres, 

peut également avoir un impact sur la précision des estimations. 

Un autre paramètre peut avoir un impact sur la réponse spectrale des pixels plastiques ou la 

capacité de détection : les matériaux humides produisent une réponse significativement plus 

faible que les matériaux secs (TOPOUZELISet al., 2020). Il se pourrait que les débris plastiques 

fussent significativement mouillés voire légèrement submergés lorsqu'ils étaient déployés en 

mer, ce qui aurait pu entraver leur détection par le satellite. 

4.1.2 Limitations rencontrées 

En raison du caractère novateur de ce domaine de recherche, la détection des débris plastiques 

à partir de données satellitaires présente certainement des faiblesses qui peuvent influencer la 

fiabilité et la précision des résultats obtenus.  

Parmi les limites méthodologiques rencontrées lors de cette étude, la résolution spatiale 

limitée à 10 mètres est un facteur clé. Cette résolution peut réduire la capacité à détecter les 

débris plastiques les plus petits, ce qui pourrait sous-estimer l'ampleur réelle de la pollution 

plastique dans notre zone d'étude. En conséquence, certains débris pourraient échapper à la 

détection, compromettant ainsi la représentativité des données recueillies. 

De plus, la couverture nuageuse relativement élevée dans certaines images lors du 

téléchargement des données, a limité notre étude au niveau temporel, rendant ainsi les images 

disponibles moins intéressantes pour l'analyse et donc une perte d'informations sur la 

distribution des débris plastiques. 

Un autre défi rencontré est le temps nécessaire au traitement des images satellitaires. Dans 

certains cas, une seule image pouvait prendre jusqu'à une semaine pour être traitée et 

analysée. Cette contrainte de temps limite le nombre d'images pouvant être analysées, ce qui 

restreint la fréquence et la couverture temporelle des observations. C’est, par ailleurs, la 

raison majeure pour laquelle nous avons choisi une image par saison. 

De plus, le traitement des données satellitaires nécessite une grande quantité d'espace de 

stockage sur l'ordinateur. Cette contrainte a limité les images satellitaires utilisées lors de 

notre étude, ce qui peut affecter la représentativité et la validité des résultats obtenus. 
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L'absence de validation in-situ constitue également une limite significative. Notre étude porte 

principalement sur des données de l'année précédente. Dans ce contexte, il n'était pas possible 

de réaliser une validation in-situ en temps réel. Cela introduit donc une incertitude dans les 

résultats. 

Enfin, nous constatons des confusions avec d'autres matériaux flottants, tels que des bateaux, 

des navires et des fermes aquacoles. Cette confusion a nécessité une analyse manuelle pour 

distinguer les débris plastiques des autres matériaux, ce qui était contraignant. 

4.2 Méthode 2 : Détection de la contamination plastique par le script de Copernicus 

Le premier aspect à souligner est que le prototype du script développé par les services 

Copernicuspermet effectivement de détecter la contamination plastique potentielle à partir des 

images Sentinel-2 téléchargées. L'analyse de ces images a permis l'élaboration de cartes 

représentants la répartition spatio-temporelle de la contamination plastique potentielle durant 

l’année 2023-2024, dont celles couvrant les zones et la période d'étude (Figure 19), afin 

d’étudier la variabilité temporelle de la contamination à une échelle plus fine, en fonction de 

la disponibilité des images.La couleur jaune des images correspond aux pixels contaminés par 

la pollution plastique, l’intensité de la couleur dépend de l’abondance de ces derniers. 

La classification supervisée est cruciale pour visualiser de manière concrète la distribution 

spatiale de la contamination plastique potentielle au fil des quatre saisons (Figure 20), ainsi 

que pour quantifier cette contamination. Néanmoins, la tentative de quantification n’a pas été 

très fructueuse en raison de la présence de pixels mixtes comme indiqué dans le Tableau 16. 

Ces pixels ont conduit à une surestimation de la contamination plastique dans certaines 

régions et saisons par exemple le printemps, et à une sous-estimation dans d'autres comme 

l’automne. De ce fait, ces résultats n’ont pas été discutés, et seule la distribution spatiale a été 

abordée en détail. 

Tableau 16: Quantification de la contamination plastique potentielle. 

Zone d’étude 
 Printemps 

(25/03/2023) 

Été 

(12/08/2023) 

Automne 

(06/10/2023) 

Hiver 

(03/02/2024)  

Nombre de pixels « Contamination potentielle » 1 471 583 1 375 686 16 694 208 547 

Nombre de pixels « Non-contamination »  295 010 390 907 1 749 899 1 558 046 

Superficie totale de contamination potentielle (km²) 3210,45 3001 36,42 455 

% Contamination plastique 83,3  77,87 0,94 11,81 
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Figure 19: Cartes représentants la répartition de la contamination plastique potentielle pour chaque saison sur une échelle 
bleu foncé/jaune (le bleu foncé représente l'absence de contamination, le jaune correspond à la présence de plastique). 
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Figure 20: Cartes représentants le résultat de la classification supervisée de la contamination plastique potentielle pour chaque saison. 
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Au printemps, une faible contamination plastique est observée dans les deux baies de Bou Ismail et 

d’Alger, ce qui pourrait s'expliquer par les conditions météorologiques favorables, telles que des 

faibles précipitations entraînant un ruissellement minimal des déchets plastiques depuis les zones 

urbaines et industrielles vers les deux baies. De plus, les courants marins actifs peuvent jouer un 

rôle crucial en aidant à disperser tout déchet présent et à prévenir une accumulation significative le 

long des rivages. 

En été, une augmentation notable de la contamination plastique est observée, en particulier le long 

de la Baie d'Alger et de la Baie de Bou Ismail. Les taches jaunes se sont étendues, couvrant une plus 

grande partie du littoral Algérois par rapport au printemps. Cette augmentation peut être attribuée à 

l'augmentation significative des activités récréatives et touristiques, surtout au niveau de la baie de 

Bou Ismail, avec des plages plus fréquentées, augmentant ainsi la quantité de déchets produits et 

potentiellement mal gérés. De plus, la direction des courants marins vers l'ouest joue un rôle crucial 

en facilitant la dispersion des déchets plastiques le long de la côte. 

En automne, une contamination plastique particulièrement concentrée est remarquée au niveau de la 

Baie d'Alger. Cela pourrait être la conséquence de l'intensité de l'activité industrielle et la forte 

urbanisation autour de la baie, contribuant ainsi à une production élevée de déchets plastiques. Les 

précipitations abondantes de la saison ont entraîné un ruissellement considérable de ces déchets 

depuis les zones urbaines et industrielles vers la baie. De plus, la morphologie semi-circulaire de la 

baie a limité la dispersion des déchets plastiques, favorisant leur accumulation près des zones 

portuaires et des embouchures des oueds d’El Hamiz et d’El Harrach. En revanche, les autres baies 

comme Bou Ismail, El Djamila et Zemmouri ont présenté une contamination moindre, 

probablement en raison des activités industrielles moins intenses. 

En hiver, une contamination plastique modérée est constatée le long du littoral. La région centrale 

de la Baie d'Alger (embouchures des oued El Harrach et El Hamiz), la baie d’El Djamila et l’est de 

la baie de Bousmail (embouchure des oueds Beni Messous et Mazafran) présentent la 

contamination la plus significative, principalement concentrée près des zones urbaines et 

industrielles, probablement en raison de l’activité humaine élevée et du ruissellement provenant des 

régions urbanisées. Dans les baies de Boumerdes et de Bou Ismail, la contamination semble moins 

intense mais est toujours présente. Cette situation est vraisemblablement liée aux tempêtes 

hivernales, qui peuvent entraîner une accumulation notable de débris plastiques le long des côtes. 
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En comparant les résultats qualitatifs des deux méthodes utilisées, à savoir celle qui détecte les 

débris macroplastiques à l'aide d'indices spectraux et celle qui identifie la contamination plastique 

via le script développépar Copernicus, nous constatons que les pixels identifiés par la première 

méthode correspondent bien aux zones de contamination plastique potentielle indiquées par la 

deuxième méthode. Cependant, l'intensité de la contamination varie entre les deux méthodes. Cette 

divergence pourrait s'expliquer par le fait que la deuxième méthode ne détecte probablement pas 

uniquement les macroplastiques, mais aussi d'autres formes de débris plastiques. 

Concernant l’étude temporelle plus détaillée de la répartition de la contamination plastique 

potentielle le long du littoral algérois au cours de l’année 2023 à 2024, nous avons identifié deux 

phases distinctes (Figure 21 et Figure 22).  

La première phase, allant de fin mars 2023 au début août 2023, montre une faible contamination 

plastique le long des trois baies, avec des niveaux minimaux observés, notamment le 26 juillet 

2023. Cette faible contamination peut être expliquée par les conditions météorologiques favorables, 

avec de faibles précipitations, et donc un ruissellement minimal des déchets plastiques. De plus, les 

mesures de la collecte des déchets avant la haute saison touristique réduit la production de déchets 

plastiques.  

La deuxième phase, allant de mi-août 2023 au début mai 2024, révèle une augmentation 

significative de la contamination plastique, avec des pics notables le 6 octobre 2023 et le 25 

novembre 2023. Lors de ces périodes, une concentration élevée de déchets plastiques a été 

constatée, d'abord dans la Baie d'Alger puis le long du littoral algérois. Cette augmentation peut être 

due à l'activité touristique et récréative accrue à la fin de l'été et au début de l'automne avec une 

fréquentation plus importante des plages et donc une production accrue de déchets plastiques, 

souvent mal gérés. Les conditions météorologiques défavorables, avec des précipitations 

abondantes en automne et en hiver, et donc un ruissellement considérable des déchets plastiques 

depuis les zones urbaines et industrielles vers les baies est un facteur clé. Il est important également 

de signaler l’importance des courants marins dans la dispersion de la pollution plastique. 
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Figure 21 : Cartes représentants la répartition spatio-temporelle de la contamination plastique potentielle durant l’année 2023-2024 sur une 

échelle bleu foncé/jaune (le bleu foncé représente l'absence de contamination, le jaune correspond à la présence de plastique). 
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Figure 22 : Cartes représentants la répartition spatio-temporelle de la contamination pastique potentielle durant l’année 2023-2024 sur une 
échelle bleu foncé/jaune (le bleu foncé représente l'absence de contamination, le jaune correspond à la présence de plastique). 
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4.3 Etude des sources de pollution 

4.3.1 Etude de l’occupation du sol 

L'analyse des cartes élaborées après la classification supervisée pour les wilayas d’Alger, de 

Boumerdes et de Tipaza révèle une variabilité significative dans l'occupation des sols, ce qui 

indique des sources potentielles de pollution plastique différentes sur le littoral Algérois 

(Figure 23, Figure 24, Figure 25). L’interprétation des superficies et pourcentages calculés 

pour les cinq classes : eau, sols nus, terres agricoles, urbanisation et végétation, comme 

indiqué dans la Figure 26, met en lumière cette diversité. 

 

Figure 23 : Cartes d’occupation du sol de la wilaya d’Alger. 

 

Figure 24 : Cartes d’occupation du sol de la wilaya de Boumerdes. 
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Figure 25 : Cartes d’occupation du sol de la wilaya de Tipaza. 

 

 

 

Figure 26 : Superficies et pourcentages des classes d’occupation du sol dans les communes côtières 
des trois wilayas. 
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4.3.1.1 Alger 

À Alger, la forte urbanisation est particulièrement évidente dans les zones côtières et 

centrales. Les données montrent que l'urbanisation représente environ 50 % de la superficie 

totale de ses communes côtières, soit environ 100 km². Cette densité urbaine est une source 

majeure de pollution plastique marine en raison de la concentration de population, des 

activités industrielles et d'une gestion souvent inadéquate des déchets solides. La proximité de 

ces zones urbanisées avec la côte facilite le transport des débris plastiques vers le littoral par 

le vent, les cours d'eau (Oued El Hamiz et Oued El Harrach) et les systèmes de drainage 

urbains. 

La présence de végétation et de terres agricoles en périphérie, couvrant également environ 20 

% (~24 km²), peut agir comme un tampon, capturant certains débris plastiques. Cependant, les 

sols nus, qui représentent près de 15 % (25 km²), peuvent contribuer à la dispersion des 

déchets car il est dépourvu de couverture végétale, il est donc plus susceptible d'être érodé par 

l'eau et le vent. Ce processus peut entraîner le déplacement de déchets, y compris les débris 

plastiques. 

4.3.1.2 Boumerdes 

À Boumerdes, la végétation et les terres agricoles prédominantes couvrent près de 80 % de la 

superficie totale des communes côtières, soit environ 350 km², indiquant une couverture 

végétale dense qui peut limiter la dispersion des plastiques en agissant comme une barrière 

physique. Cependant, la dégradation des plastiques peut toujours se produire et affecter les 

sols et les cours d'eau. 

L'urbanisation, bien que moins dense qu'à Alger, est présente le long de la côte et à l'ouest de 

la wilaya, représentant environ 10 % de la superficie totale, soit environ 50 km². Même une 

urbanisation modérée peut contribuer à la pollution plastique, en particulier dans les zones 

côtières où les déchets peuvent rapidement atteindre la mer à travers les cours d’eau tels que 

l’Oued de Réghaia, Boudouaou, Corso, Boumerdes et Isser. 

4.3.1.3 Tipaza 

À Tipaza, la couverture végétale et agricole est dominante, représentant environ 75 % de la 

superficie totale des communes côtières, soit environ 650 km², ce qui peut aider à limiter la 

dispersion des plastiques vers la mer. Cependant, l'urbanisation, bien que moins étendue 
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comparée aux autres wilayas, couvre environ 10 % de la superficie totale, soit environ 35 km², 

principalement le long des axes principaux et de la côte. 

La forte présence de terres agricoles, couvrant environ 30 % de la superficie totale, soit 

environ 105 km², implique que les pratiques agricoles peuvent être une source significative de 

pollution plastique. Notamment, la dégradation des serres agricoles sous l'effet de l'irradiation 

solaire est une source potentielle de microplastiques. Ces derniers, une fois libérés, sont 

susceptibles d'être transportés vers la mer par les vents dominants, contribuant ainsi à la 

contamination des écosystèmes marins. La faible proportion de sols nus, environ 5 %, soit 

environ 50 km², est également notable. 

4.3.2 Autres sources de pollution 

Pour obtenir une vue globale des diverses sources de pollution plastique, nous avons élaboré 

ces cartes récapitulativespour chaque wilaya (Alger, Boumerdes, Tipaza) (Figure 27, Figure 

28, Figure 29) dont les données démographiques sont estimées à partir du recensement de 

2008 réalisé par l'Office National des Statistiques (ONS), tandis que les informations relatives 

aux zones industrielles sont tirées des travaux de recherche d’AROUR (2014). 

 

 

Figure 27 : Carte des sources de pollution dans la wilaya d'Alger. 

(Sources des données : démographie : ONS (2008), zones industrielles : AROUR (2014), réseau 
hydrographique : digitalisation à partir de GoogleEarth 2024) 
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Figure 28 : Carte des sources de pollution dans la wilaya de Boumerdes. 

(Sources des données : démographie : ONS (2008), zones industrielles : AROUR (2014), réseau 
hydrographique : digitalisation à partir de GoogleEarth 2024) 

 

 

Figure 29 : Carte des sources de pollution dans la wilaya de Tipaza. 

(Sources des données : démographie : ONS (2008), zones industrielles : AROUR (2014), réseau 
hydrographique : digitalisation à partir de GoogleEarth 2024) 
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4.3.2.1 Alger 

Les zones d'activités industrielles, signalées par les triangles rouges, sont particulièrement 

concentrées le long des oueds El Harrach et El Hamiz. Ces cours d'eau traversent des zones 

industrielles majeures ainsi que des agglomérations urbaines importantes comme Baraki et El 

Harrach, avec des populations dépassant les 130 000 habitants pour Bordj el Kiffan et Gué de 

Constantine. La proximité entre les zones industrielles et les cours d'eau augmente le risque 

de pollution plastique, car ces oueds drainent les déchets industriels et urbains vers la mer, 

exacerbant la pollution dans la baie d'Alger. 

4.3.2.2 Boumerdes 

Boumerdes présente une densité de population inférieure à celle d'Alger, mais certaines zones 

montrent des concentrations significatives, notamment les communes de Khemis El Khechna 

et Boudouaou qui comptent une population de plus de 70 000 habitants. Les zones d'activités 

industrielles sont principalement situées le long des cours d'eau tels qu’oued Reghaia et Isser, 

qui traversent les régions urbanisées stratégiquement situées près d’eux, augmentant le risque 

que les déchets plastiques soient transportés vers la mer. 

4.3.2.3 Tipaza 

Tipaza montre une densité de population globalement plus faible, avec des zones de 

concentration notables à Kolea, Fouka, Hadjout et Cherchel. Les populations dans ces 

communes dépassent les 48 000 habitants. Les zones d'activités industrielles, bien que moins 

nombreuses, sont situées près des principaux cours d'eau tel qu’oued de Mazafran, ce qui pose 

un risque potentiel de pollution plastique. La pollution plastique y est peut-être moins intense 

comparée à Alger, mais reste significative. 

Il est important à signaler que les données de population utilisées pour cette étude proviennent 

du recensement de 2008. Depuis, la population a certainement beaucoup évolué tant sur le 

plan quantitatif que dans sa distribution. 

Il est important de noter également que les oueds drainent la pollution beaucoup plus en hiver 

et au printemps lorsque les débits sont maximaux. Pendant ces saisons, les précipitations sont 

plus abondantes, ce qui entraîne un écoulement plus important des cours d'eau, transportant 

ainsi les déchets plastiques accumulés vers la mer. Cela aggrave donc le problème de la 

pollution plastique dans les trois baies. 
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4.4 Recommandations pour une gestion durable des déchets plastiques marins en 

Algérie 

Pour gérer efficacement les déchets plastiques marins en Algérie, plusieurs stratégies peuvent 

être mises en œuvre en tenant compte des spécificités locales et des expériences réussies 

ailleurs. 

4.4.1 Renforcement du cadre réglementaire 

L'Algérie pourrait s'inspirer des législations adoptées par d'autres pays méditerranéens et 

européens pour interdire les plastiques à usage unique. En 2020, l'Union Européenne a adopté 

une directive visant à interdire une série de produits en plastique à usage unique, comme les 

pailles, les couverts, et les bâtonnets de coton-tige (Annexe 3). Cette approche réglementaire a 

non seulement réduit la consommation de ces produits, mais a également stimulé l'innovation 

dans le développement d'alternatives durables. En Algérie, une loi similaire pourrait être mise 

en place pour restreindre l'utilisation des plastiques à usage unique, tout en encourageant la 

production et l'utilisation d'alternatives biodégradables et réutilisables. 

Il est également important de noter qu'à ce jour, l'Algérie ne dispose pas de législation 

spécifique concernant la pollution par les microplastiques, malgré son importance croissante 

pour l'environnement marin et la santé humaine. D'autres pays ont déjà pris des mesures en ce 

sens. Par exemple, le Canada a adopté en 2017 les "Microbeads in ToiletriesRegulations", qui 

interdisent la fabrication, l'importation et la vente de produits de toilette contenant des 

microbilles de plastique (GOUVERNEMENT DU CANADA, 2017). 

4.4.2 Amélioration des infrastructures de gestion des déchets 

L'amélioration des infrastructures de gestion des déchets est essentielle pour prévenir la fuite 

des plastiques dans l'environnement marin. L'Allemagne offre un exemple notable avec son 

système de consigne pour les bouteilles en plastique. Ce système incite les consommateurs à 

retourner leurs bouteilles usagées en échange d'une petite somme d'argent, ce qui a 

considérablement augmenté les taux de recyclage (DALBERG ADVISORS, 2019). En Algérie, la 

mise en place d'un système similaire pourrait être envisagée, accompagné de centres de tri et 

de recyclage modernes et bien équipés. De plus, l'amélioration de la collecte des déchets dans 

les zones urbaines et rurales contribuerait à une gestion plus efficace et à la réduction de 

l'enfouissement illégal des déchets. 

Il est également crucial de considérer les stations de traitement des eaux usées en Algérie. 

Actuellement, le pays dispose de 211 stations d'épuration, dont 71 à affinage naturel, avec une 
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capacité totale de 1 milliard de mètres cubes d'eau traitée par an. Cependant, seulement 480 

millions de mètres cubes sont effectivement épurés, soit un taux de 47%, souvent à cause du 

manque de raccordement des eaux usées (BLIDI, 2023). Pour résoudre efficacement le 

problème de la pollution plastique, il est impératif de traiter non seulement les eaux usées 

domestiques, mais aussi les rejets industriels. Une application stricte de la loi fixant les 

normes de rejets industriels est nécessaire pour réduire significativement l'impact de la 

pollution plastique sur les écosystèmes marins et les communautés côtières. Malgré ces défis, 

des efforts importants sont en cours pour améliorer la situation; en janvier 2023, 16 stations 

supplémentaires étaient en cours de réalisation, ajoutant 140 millions de m³/an à la capacité de 

traitement actuelle. Ces initiatives s'inscrivent dans un plan national visant à valoriser les eaux 

non conventionnelles pour lutter contre le stress hydrique (APS, 2023). En renforçant ces 

efforts, l'Algérie peut espérer réduire la pollution plastique et améliorer la gestion durable de 

ses ressources en eau. 

4.4.3 Sensibilisation et éducation environnementale 

La sensibilisation et l'éducation du public sont des éléments clés pour assurer la durabilité des 

efforts de gestion des déchets. En Norvège, l'éducation environnementale est intégrée dans le 

cursus scolaire dès le plus jeune âge, ce qui a contribué à une prise de conscience élevée et à 

une forte culture de recyclage parmi les citoyens (WEBINTELLIGENCE, 2024). En Algérie, bien 

que des efforts notables soient réalisés par plusieurs associations actives dans le domaine de 

l'écologie, il serait bénéfique de renforcer les campagnes de sensibilisation nationales visant à 

informer le public sur les impacts des déchets plastiques sur l'environnement marin et à 

promouvoir des comportements responsables, comme la réduction de l'utilisation de 

plastiques et le tri des déchets. 
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CONCLUSION 

L'objectif principal de cette étude était d'évaluer l'applicabilité et l'efficacité des techniques de 

télédétection spatiale pour détecter les débris plastiques le long du littoral Algérois. L'étude a 

mis en lumière l'utilisation du MSI Sentinel-2 à travers deux indices, l'Indice des Débris 

Flottants (FDI) et l'Indice de Végétation à Différence Normalisée (NDVI), en utilisant le 

logiciel SNAP. Les résultats ont démontré que non seulement les matériaux plastiques ont pu 

être détectés, mais également d'autres matériaux flottants tels que des bateaux, des navires, 

des fermes aquacoles, etc. Après vérification, le nombre de pixels de plastique a été limité à 

26pixels, ce qui correspond à environ 13 000 kg de plastique selon l'échelle de KIKAKIet al. 

(2020). La variation temporelle et spatiale a montré que la baie de Zemmouri en automne 

présentait la plus grande quantité de débris plastiques. 

Une deuxième approche consistait à détecter la contamination plastique à l'aide du script de 

Copernicus développé par MELYKUTI (2019) en utilisant différentes méthodes d'apprentissage 

automatique. Les résultats de l'étude sur une période temporelle allant de 2023 à 2024 ont 

révélé deux phases distinctes. La première phase, de mars à août 2023, a montré une faible 

contamination plastique le long des trois baies, avec des niveaux minimaux observés, 

notamment le 26 juillet 2023. La deuxième phase, d'août 2023 à mai 2024, a révélé une 

augmentation significative de la contamination plastique, avec des pics notables le 6 octobre 

2023 et le 25 novembre 2023.Cette tendance est probablement la conséquence des variations 

saisonnières des conditions météorologiques et hydrographiques, tel que les précipitations et 

le débit des oueds, qui affectent le transport et l'accumulation des débris plastiques sur le 

littoral Algérois. 

Pour identifier les sources potentielles des débris plastiques flottants et interpréter les résultats 

de manière plus précise et contextualisée, une étude de l'occupation du sol dans les wilayas 

d'Alger, de Boumerdes et de Tipaza a été menée à travers une classification supervisée en 

utilisant le logiciel ENVI. L'analyse des résultats a révélé une variabilité significative dans 

l'occupation du sol, indiquant ainsi des sources potentielles de pollution plastique différentes 

le long du littoral algérois. À Alger, l'urbanisation représente environ 50 % de la superficie 

totale de ses communes côtières, soit environ 100 km². En comparaison, Boumerdes et Tipaza 

présentent des taux d'urbanisation plus faibles, avec 10 % de leurs superficies côtières 

urbanisées. Cette urbanisation se concentre près du littoral et sur les rives des oueds, ce qui 
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favorise l'acheminement de la pollution plastique vers la mer. Les oueds drainent également la 

pollution plastique des zones industrielles des trois wilayas. 

Il est clair que la question environnementale est devenue un enjeu majeur en Algérie, compte 

tenu de l'importance des ressources naturelles marines pour le développement économique du 

pays, mais également des conséquences désastreuses de la pollution plastique sur ces 

écosystèmes. Toutefois, l’analyse critique de la prise en charge de l'environnement marin par 

les textes juridiques du pays révèle des limites et des insuffisances persistantes. Il est donc 

primordial que l'Algérie renforce sa capacité institutionnelle et humaine pour mettre en œuvre 

les textes juridiques existants, ainsi que pour répondre aux enjeux environnementaux marins 

actuels. 

À cette fin, une surveillance complète des débris marins plastiques est nécessaire, nécessitant 

une approche interdisciplinaire. Bien que les données satellitaires permettent actuellement la 

détection des débris flottants en surface, elles ne fournissent pas d'informations sur les débris 

submergés. Il est donc essentiel de mener des campagnes sur le terrain, accompagnées 

d'observations auxiliaires, pour examiner en détail l'impact des conditions météorologiques et 

des processus océanographiques sur la distribution des plastiques à la surface de la mer. De 

plus, l'utilisation de satellites optiques dotés d'une résolution spatiale plus élevée pourrait 

améliorer la précision des indices appliqués, permettant ainsi une meilleure identification et 

un suivi plus précis des débris plastiques. Pour approfondir encore nos recherches, il serait 

bénéfique d'étendre nos études à d'autres zones géographiques et de considérer une 

perspective temporelle.Il serait donc plus approprié de prendre en considération l'intégralité 

des bassins versants drainés par les oueds de la région. Cela permettrait d'obtenir une 

évaluation plus complète et précise des sources de pollution et de leur impact sur 

l'environnement. En outre, l'utilisation de pixels validés pour la classification pourrait 

constituer une méthode prometteuse pour améliorer nos analyses et renforcer la fiabilité de 

nos résultats, comme l'ont démontré certaines recherches antérieures(SANNIGRAHIet al., 2021; 

TOPOUZELISet al., 2020). 
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Annexe 1 

Les engagements environnementaux internationaux de l’Algérie 

 

 1982 – Convention relative aux zones humides d’importance internationale du 02 Février 

1971 à Ramsar (Iran) pour la conservation et l’utilisation rationnelle des zones humides 

par des actions locales, régionales et nationales et par la coopération internationale, en tant 

que contribution à la réalisation du développement durable dans le monde entier.  

 1982 – Convention sur le commerce international des espèces de faune et de flore 

sauvages menacées d’extinction (03 Mars 1973) à Washington. 

 1991 – Convention de Bamako sur l’interdiction d’importer en Afrique des déchets 

dangereux et sur le contrôle des mouvements transfrontières et la gestion des déchets 

dangereux produits en Afrique. 

 1992 – Convention de Rio sur la diversité biologique.  

 1992 – Convention-cadre des Nations Unies sur les Changements Climatiques. 

 1995 – Décret présidentiel n° 95–163 du 6 Juin 1995 portant ratification de la convention 

sur la diversité biologique, signée à Rio de Janeiro le 5 Juin 1992.  

 1996 – Ordonnance n° 96–04 du 10 Janvier 1996 portant approbation de la Convention 

des Nations Unies sur la lutte contre la désertification.  

 1998 – Convention de Bâle sur le contrôle des mouvements, transfrontières de déchets 

dangereux et de leur élimination adoptée par la conférence de plénipotentiaires.  

 1999 – Décret présidentiel n° 99–115 du 14 Juin 1999 portant ratification de 

l’amendement au Protocole de Montréal adopté par la quatrième réunion des parties à 

Copenhague, 23–25 Novembre 1992.  

 2001 – Convention de Stockholm sur les polluants organiques persistants.  

 2006 – Décret présidentiel n° 06–170 du 22 Mai 2006 portant ratification de 

l’amendement à la Convention de Bâle sur le contrôle des mouvements transfrontières de 

déchets dangereux et de leur élimination, adopté à Genève le 22 Septembre 1995. 

 2006 – Décret présidentiel n° 06–405 du 14 Novembre 2006 portant ratification du 

Protocole relatif aux aires spécialement protégées et à la diversité biologique en 

Méditerranée, signé à Barcelone le 10 Juin 1995.  

 2006 – Décret présidentiel n° 2006–206 du 7 Juin 2006 portant ratification de la 

Convention de Stockholm sur les polluants organiques persistants, adoptée à Stockholm le 

22 Mai 2001.  
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 2007 – Décret présidentiel n° 07–93 du 19 Mars 2007 portant ratification de 

l’amendement au Protocole de Montréal adopté par la neuvième réunion des parties à 

Montréal, 15 – 17 Septembre 1997. 

 2007 – Décret présidentiel n° 07–94 du 19 Mars 2007 portant ratification de 

l’amendement au Protocole de Montréal relatif aux substances qui appauvrissent la couche 

d’ozone, adopté à Beijing le 3 Décembre 1999.  

 2007 – Décret présidentiel n° 07–95 du 19 Mars 2007 portant ratification de l’Accord sur 

la conservation des cétacés de la Mer Noire, de la Méditerranée et de la zone atlantique 

adjacente, signé à Monaco le 24 Novembre 1996.  

 2011 – Décret présidentiel N° 11–246 du 10 Juillet 2011 portant adhésion de la république 

algérienne démocratique et populaire à la Convention Internationale sur l’intervention en 

haute mer en cas d’accident entraînant ou pouvant entraîner une pollution par les 

hydrocarbures, adoptée à Bruxelles le 29 Novembre 1969 et son protocole, fait à Londres 

le 02 Novembre 1973.  

 2011 – Protocole de Kyoto à la Convention-cadre des Nations Unies sur les Changements 

Climatiques.  

 2012 – Décret présidentiel n°12–416 du 11 Décembre 2012 Portant ratification du 

Mémorandum d’entente entre le Gouvernement de la République algérienne démocratique 

et populaire et le Gouvernement de la République tunisienne dans les domaines de la 

maîtrise de l’énergie et des énergies renouvelables, signé à Alger le 2 Juillet 2009.  

 2013 – Convention de Minamata sur le mercure, adoptée à Kumamoto (Japon).  

 2014 – Décret présidentiel n° 14–376 du 30 Décembre 2014 portant ratification du 

Mémorandum d’entente entre le Gouvernement de la République algérienne démocratique 

et populaire et le Gouvernement de l’État du Koweït dans le domaine de l’environnement 

et du développement durable, signé à Koweït-City le 2 Octobre 2013.  

 2015 – Décret présidentiel n° 15–119 du 13 Mai 2015 portant acceptation de 

l’amendement de Doha au Protocole de Kyoto la Convention-cadre des Nations unies sur 

les changements climatiques, adopté Doha, Qatar, le 8 Décembre 2012. 

 2016 – Décret présidentiel n° 16–262 du 13 Octobre 2016 portant ratification de l’Accord 

de Paris sur les changements climatiques adopté le 12 décembre 2015 JO.N° 60 du 13 

Octobre 2016. 
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Annexe 2 

Script de détection des plastiques océaniques de Sentinel Hub 

 

/* 

Auteur du script:BenceMélykúti, DPhil (Oxf) 

*/ 

var estimator = -1.76e-05 + 10000*(-0.0003402*B01 -0.0004585*B02 + 0.001415*B03 + 

0.01254*B04 -0.01112*B05 -0.01346*B06 + 0.002762*B07 + 0.002481*B08 + 

0.009605*B8A + 0.001247*B09 -0.01462*B11 + 0.00406*B12); 

function clamp (a) { 

  return a<-1 ?0 : a > 1 ? 1 : (1+a)/2; 

} 

function cividis (x) { 

  // x must be in [0,1] 

  // https://github.com/matplotlib/matplotlib/blob/master/lib/matplotlib/_cm_listed.py 

  return [x*0.995737, x*0.909344+(1-x)*0.135112, x*0.217772+(1-x)*0.304751]; 

} 

var NDWI = (B03 - B08) / (B03 + B08); 

return NDWI <0 ? [2.5*B04, 2.5*B03, 2.5*B02] :cividis(clamp(estimator)); 
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Annexe 3 

Aperçu des interdictions de plastique dans certains pays méditerranéens sélectionnés (Source : DALBERG ADVISORS, 2019). 

Pays Sacs Couverts Cotons-tiges Gobelets Micro-billes 

FRA 

2016 : Interdiction de la distribution 
des sacs, sauf compostables ou 
biosourcés  
2016 : Minimum de contenu bio-
sourcé dans les sacs d'ici 2025 

2020 : Interdiction des cotons-tiges, couverts, verres et assiettes (à l'exception des 
couverts/verres/assiettes compostables et compostés à domicile et en partie biosourcés), pailles, 
couverts jetables, touillettes, couvercles jetables, barquettes alimentaires, pots, boîtes à salade, 

boîtes à boissons et agitateurs 

2018 : Interdiction de l'introduction de 
nouveaux cosmétiques exfoliants 
contenant des microplastiques 

ITA 

2011 : Interdiction de fabrication, 
distribution et importation de sacs 

non biodégradables  
2018 : Interdiction des sacs 
plastiques ultra-légers pour les 
fruits et légumes 

2019 : Interdiction de la fabrication et de la vente de cotons-tiges avec bâtonnet en plastique 
2020 : Interdiction de la vente de tous 
les cosmétiques exfoliants ou détergents 
contenant des microplastiques 

CRO 

2019 : Taxe d'usage habituel et 
redevance pour les distributeurs de 
sacs plastiques de $1,500/T pour les 
sacs non biodégradables 

2019 : Le Parlement a voté l'interdiction des plastiques à usage unique : couverts, cotons-tiges, 
pailles, agitateurs, et gobelets en polystyrène issus de plastiques oxo-dégradables selon la directive 
européenne sur les plastiques à usage unique 

 

GRE 

2018 : Taxe de 0,04 € sur les sacs 
plastiques, augmentée à 0,09 € en 
2019 

    

TUR 

2019 : 0,25 TL de taxe sur les sacs 
plastiques pour réduire la 
consommation de 440 à 90 sacs par 
habitant d'ici 2025 

    

TUN 
2017 : Interdiction de la vente des 
sacs plastiques 

    

MAR 

2015 : Interdiction de la production, 
vente et utilisation de sacs 
plastiques non biodégradables 

   

 
 
 
 
 



 

 

 

RESUME 

Les déchets plastiques flottants dans l'océan constituent un problème majeur à l'échelle mondiale. Cette étude se concentre 

sur la détection des débris plastiques marins le long du littoral Algérois en utilisant l'Indice des Débris Flottants (FDI) et 

l'Indice de Végétation à Différence Normalisée (NDVI) pour le traitement des images satellitaires Sentinel-2 MSI niveau 2A, 

corrigées des effets atmosphériques par Sen2Cor, ainsi que le script de Copernicus utilisant l'Indice de l'Eau Normalisée 

(NDWI). Les images présentent une résolution spatiale de 10 mètres et couvrent la baie d’Alger, la baie de Zemmouri et la 

baie de Bou Ismail. Les résultats indiquent la détection de 26 pixels de plastique, équivalant à environ 13 000 kg de déchets 

plastiques. Une augmentation notable de la pollution plastique a été observée, avec des pics enregistrés le 6 octobre et le 25 

novembre 2023. De plus, une analyse détaillée de l'occupation du sol montre que l'urbanisation constitue environ 50 % de la 

superficie totale des communes côtières d'Alger, soit environ 100 km². Ces résultats soulignent l'importance d'une approche 

interdisciplinaire pour une gestion efficace des déchets plastiques marins en Algérie et la nécessité de renforcer les mesures 

de mise en œuvre sur le terrain. 

Mots-clés: Télédétection, Déchets Plastiques, Sentinel-2, FDI, Littoral Algérois 

 

ABSTRACT 

Floating plastic debris in the ocean constitutes a major global problem. This study focuses on detecting marine plastic debris 

along the Algerian coastline using the Floating Debris Index (FDI) and the Normalized Difference Vegetation Index (NDVI) 

for processing Sentinel-2 MSI Level 2A satellite images, corrected for atmospheric effects by Sen2Cor, as well as the 

Copernicus script using the Normalized Water Index (NDWI). The images have a spatial resolution of 10 meters and cover 

the Bay of Algiers, the Bay of Zemmouri, and the Bay of Bou Ismail. The results indicate the detection of 26 plastic pixels, 

equivalent to approximately 13,000 kg of plastic debris. A notable increase in plastic pollution was observed, with peaks 

recorded on October 6, and November 25, 2023. Additionally, a detailed land use analysis showed that urbanization 

constitutes about 50% of the total area of the coastal communes of Algiers, approximately 100 km². These results underscore 

the importance of an interdisciplinary approach for effective marine plastic waste management in Algeria and the need to 

strengthen implementation measures on the ground. 

Key-words: Remote Sensing, Plastic Debris, Sentinel-2, FDI, Algerian coastline 

 

 الملخص

ول الساحل على طلطافية استيكية النفايات البلالصعيد العالمي. تركز هذه الدراسة على اكتشاف تشُكل النفايات البلاستيكية الطافية في المحيط مشكلةً كبيرة على ا

، المصححة من 2A المستوى Sentinel-2 MSI لمعالجة صور الأقمار الصناعية ومؤشر الفرق النباتي المعياري النفايات الطافيةالجزائري باستخدام مؤشر 

يج الجزائر وخليج أمتار وتشمل خل 10تبلغ دقة الصور  .بمؤشر الماء المعياري Copernicusوكذلك باستخدام سكريبت، Sen2Cor التأثيرات الجوية بواسطة

ية. لوحظت زيادة كبيرة في من النفايات البلاستيك كغ 13,000بيكسل من البلاستيك، ما يعادل حوالي  26. تشير النتائج إلى اكتشاف بومرداس وخليج بو إسماعيل

يشكل المخطط العمراني  ن. بالإضافة إلى ذلك، يظُهر تحليل تفصيلي لاستخدام الأراضي أ2023نوفمبر  25أكتوبر و 6بلاستيكي، مع تسجيل ذروتين في التلوث ال

عدد التخصصات للإدارة مت نهج إتباع تؤكد هذه النتائج على أهمية. ²كم 100، أي ما يقرب من للبلديات الساحلية في الجزائر% من المساحة الإجمالية 50حوالي 

 الفعالة للنفايات البلاستيكية البحرية في الجزائر والحاجة إلى تعزيز تدابير التنفيذ على أرض الواقع.

 ، مؤشر النفايات الطافية، الساحل الجزائريSentinel-2الاستشعار عن بعد، النفايات البلاستيكية،  الكلمات المفتاحية:
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